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1.0 QUALITY ASSURANCE

1.1 UNIT DESCRIPTION

The Forensic Biology Unit is comprised of Criminalists, a DNA Technical Manager, a CODIS Administrator, a
Laboratory Technician, and two Supervising Criminalists. The unit is generally staffed from 0700-1700hrs
Monday through Friday.

The Forensic Biology laboratory is divided into three distinct areas on the 6th floor of the SDPD headquarters
building: the main laboratory area which is used for the purposes of screening items ot wvidence and the DNA
extraction process; a room dedicated to PCR setup; and a separate area dedicated.to'the preparation and analysis

of amplified DNA.

1.2 UNIT FUNCTIONS

The Forensic Biology Unit aims to provide analysis on all reasctiable mequests from any investigative units of the

San Diego Police Department using the most current technt \loc‘les ~vailable.

The Forensic Biology Unit’s primary duties are to amalvze items of physical evidence to locate and identify

biological material, and perform DNA analysis anthat b ological material.

The biological materials that the Unit can prsuisptively identify, or confirm the presence of, are blood, semen,
saliva, and feces. DNA analysis may bepericrmed on all of these materials as well as hair, bone, and other body

fluids or tissues.

The DNA testing capabilities of the Forensic Biology Unit include both autosomal and Y-chromosome STR DNA
testing.

Additional duties per ormed by the Forensic Biology Unit include the validation and implementation of new

technologies, courtroom testimony, and crime scene reconstruction.
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1.3 PERSONNEL AND JOB DESCRIPTIONS

1.3.1 SUPERVISING CRIMINALIST

The Supervising Criminalist of the Forensic Biology Unit will oversee the Forensic Biology Unit and analysts.
The responsibilities will include assigning casework, interacting with attorneys and detectives to determine
case priorities, reviewing the work product of all analysts, and monitoring the overall job performance of

analysts.

Duties and responsibilities: (The duties of Supervising Criminalist and DNA Technicai,Manager may be

assigned to a single person.)

A. Establishes casework priorities based on negotiations and discussions ‘with investigators and district
attorneys.

B. Assigns casework to analysts.

C. Reviews reports and examines case notes.

D. Reviews and evaluates the performance Gf subc rdinates.

E. Works with the DNA Technical M . Jero review and establish Unit specific policies and analytical
procedures when appropriate.

F. Interviews and hires new,enpic yees.
G. Trains the new < pievess on department policies and procedures.

H. Works with the LNA Technical Manager to coordinate analyst training.

L. Keeps track of workload statistics.

J. Prepares budget requests.

K. Holds Unit meetings to disseminate department, laboratory, or unit specific information.
L. Prepares reports as required by the Crime Laboratory Manager.

1.3.2 DNA TECHNICAL MANAGER

The DNA Technical Manager will oversee the technical operation of the DNA Laboratory as outlined by the
SWGDAM and the Quality Assurance Standards. The DNA Technical Manager will evaluate new
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technologies, resolve technical problems, assess and design training programs, and ensure the unit adheres to

all quality assurance guidelines. The DNA Technical Manager is authorized to shut down the DNA laboratory

should a serious technical problem develop.

Duties and responsibilities:

A.

B.

Responsible for the technical operation of the laboratory as outlined by SWGDAM.

Reviewing, revising and approving any DNA-related technical policy or procedure prior to final

approval by the QA Manager.

Approving and overseeing training of new employees (when applicable) in DN A analytical procedures,
including completion of training documentation.

Overseeing, reviewing and approving DNA method validation;, inclaing completion of validation
documentation, prior to final approval by QA Manager.

Working with the QA Manager on any QA reports i',vo]':’inzb a DNA technical issue, and reviewing and
signing off on those QA reports.

Acting as a technical reference for the QA Manager.
Performing some technical reviews o1 DN gise files.

Acting as a mediator when necassar ; in the technical review of DNA casework in the Forensic Biology
Unit.

Providing technical ~Giisuiiation as needed to the members of the Forensic Biology Unit.

Working withup ervising Criminalist and QA Manager to ensure compliance of the DNA analysts with
QA and Unit pciicies and procedures.

Reviewing ti.e DNA proficiency tests completed by the Forensic Biology Unit.
Conducting casework analysis.

Prepares reports as required by the Crime Laboratory Manager.

1.3.3 CODIS ADMINISTRATOR

The CODIS Administrator is responsible for the security and integrity of the local CODIS network, the
CODIS software, and the data within the local database. The CODIS Administrator ensures the data within
the local CODIS database is in compliance with NDIS guidelines. The CODIS administrator is authorized to
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terminate an analyst’s or the laboratory’s participation in CODIS until the reliability and security of the
computer data can be assured if an issue with the data is identified. If the CODIS Administrator determines at
any point that the CODIS network, software, or entered data has been compromised, the DNA Technical
Manager will be immediately notified. The DNA Technical Manager and CODIS Administrator will

determine the proper course of action to reinitiate participation in CODIS for the analyst(s) or laboratory..
Duties and responsibilities:

A. Oversees the entering of DNA profiles from casework into the local database.

B. Ensures that DNA profiles are searched against the local CODIS database.

C. Uploads data to the California CODIS database.

D. Downloads and searches DNA profiles from the CJIS WAN website.

E. Performs upgrades to the CODIS software with the assistanceaf the CODIS Help Desk.

F. Ensures that a backup is maintained for the inforfizetior, in the local database.

G. Schedules and documents the yearly trainit.z of aj alysts in the operation of CODIS software.

H. Disseminates CODIS information to he :est of the Forensic Biology Unit.

1.3.4 CRIMINALIST (I ANLI)

The job descriptions for Crinsialist I and T are similar except that Criminalist IT duties may be more extensive
and Criminalist I anal;ts are expected to work more independently. In addition to the normal educational
requirements of ti e/Ciiminalist position, DNA Criminalists must complete college-level classes in

Biochemistry, Molccular Biology, Genetics, and Statistics and/or Population Biology.

Criminalist I and II’s primary duties involve locating and identifying biological material on items of physical
evidence and performing DNA analysis. Analysts are required to document all exams, tests, observations,
results, summarize the findings in a written report, and if necessary, testify in courts of law.

Duties and responsibilities:

A. Receives, inventories, screens, and preserves items of physical evidence.

B. Locates and identifies biological material.
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Conducts DNA analysis to determine possible associations between the evidence and any reference
samples provided.

Writes reports summarizing the findings and provide expert testimony in court.

Remains technically current and knowledgeable in appropriate analytical methods.

Participates in the evaluation and validation of new technologies or methodologies.

Participates in any special projects as assigned by the Supervising Criminalist or Laboratory Manager.

Informs the Supervising Criminalist or DNA Technical Manager of problems ‘hac.cvelop at any stage of a

case.

Uses the technical manual, unit policies manual and general qualicy assurvnce manual to deal with any
procedural question or analytical method.

1.3.5 LABORATORY TECHNICIAN

The laboratory technician functions as a support/position for the Forensic Biology Unit. Duties include

ordering supplies, calibrating instruments, nsoniearing operating temperature of equipment, performing

routine maintenance of equipment, and ¢lcining the unit on a weekly schedule. The laboratory technician

maintains a database of all chemicals arder:d by the Unit. If the position of Laboratory Technician is unfilled

the duties and responsibilities willbe thared among current employees. Certain functions described above may

be performed by volunteers ornt{rr but only under the direct supervision of the laboratory technician or

other qualified analyst.

Duties and responsibiiitics:

A.  Checks the calibration of instruments such as pipettes, thermal cyclers, and balances.

B. Orders chemicals and supplies for Forensic Biology

C. Maintains an accurate inventory of all chemicals located in the Unit.

D. Ensures that laboratory instruments, communal work areas, and floors are cleaned and decontaminated.

E. Ensures that the operating temperatures of the Unit ovens, incubators, refrigerators, and freezers are
monitored.

F.  Ensures that victim, suspect, and physiological, and reference mouth swab kits are prepared for
departmental use or for the collection of evidence at area hospitals.
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G. Performs other tasks as assigned by the Supervising Criminalist.

1.3.6 INTERN/VOLUNTEERS

Interns (students) and volunteers (non-students) will assist the Unit by performing certain clerical duties,
cleaning the laboratory work areas and monitoring the operating temperature of equipment. These activities
will always be performed under the guidance of the Laboratory Technician or Criminalist. The Laboratory
Technician is ultimately responsible for making certain any duties completed by the interns and volunteers are

performed correctly.

Depending on the experience level of an intern or volunteer they may also b= invclved in laboratory projects
such as the validation of new technologies. This validation work will 2iways e performed under the

supervision of the DNA Technical Manager.

1.4 TECHNICAL LEAD CONTINGENCY PLAN

The Forensic Biology Unit of the San Diego Police ¢partment currently employs multiple analysts who meet
the requirements to be DNA Technical Manager. 15 the event of a vacancy in the DNA Technical Manager

position the Crime Laboratory Manager will at<rview the candidates and appoint a person to fill the vacancy.

1.5 QUALITY ASSURANCE REVIEV'S AND REPORTS

In general, Quality Assuranc: Revi»ws will be conducted when policy or method non-compliances are identified
in administrative practiccs, eviacnce handling, casework, or in proficiency test situations. Additionally, a Quality
Assurance Review will b conducted on any incident of Staff DNA Contamination or in any unexpected DNA
results in controls th#‘comnpromise the interpretation or results. If a non-compliance is found to exist, then a
Quality Incident Repcrt will be issued. Additionally, a Quality Incident Reports will be issued on any incident of
Staff DNA Contamination in which the likelihood ratio for the association is above the limited support category,
or in any unexpected DNA results in controls that compromise the interpretation of the results. Please see

policies 2.4, 4.9.1, and 4.9.3 in the Quality Assurance Manual for further information.
1.6 PROTOCOL FOR UNEXPECTED RESULTS
Detectable DNA results from a reagent blank or amplification blank, unexplainable extraneous DNA results in a

positive amplification control, or negative results from a positive control are considered unexpected results.
Other types of unexpected results may exist.
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Any unexpected results will be documented by the analyst conducting the analysis. The analyst will complete an
"unexpected result summary" [template located on the FB network H:\ Worksheets \QA worksheets] for inclusion in the
"Unexpected Result Log". This log will be maintained by the DNA Technical Manager. The DNA Technical
Manager and the Supervising Criminalist(s) of the Forensic Biolog==Iit will be notified of any unexpected
results, review, and sign off on the summary. The Quality Assuranager will review all unexpected results.
The summary sheet completed by the analyst will contain the following information: The case number, analyst
name and ID number, date of summary, date of result, and the definition and evaluation of the problem. The
summary will also detail the resolution of problem, if any, as well as the conclusion/result/interpretation. If any
protocol, policy, or reagents will be changed as a consequence of the unexpected result then these will be
documented as well.

For a data set containing a control (reagent blank, positive amplification, negative.ariplitication control,
formamide blanks) with unexpected types to be relied upon, the unexpected 1 2sults should not affect the
interpretation (the detected types should be sample specific to the control). Toiany data set containing a control
with unexpected detectable DNA types, the unexpected results normaliy will be disclosed in the report for the
associated evidence samples.

1.7 FORENSIC BIOLOGY UNIT INCIDENT LOG

The purpose of the FB incident summaries are to rronitor any incident that could indicate a problem with any lab
equipment or instrument. The FB Unit Inciden* Léo will monitor unusual events that occur during casework
that:
1. Are corrected prior to the isstancy o1 any reports for the affected cases.
2. Do not ultimately affect<¢hevenorted results.
3. Do not require formal QA locumentation, unless otherwise determined by the DNA Technical
Manager or Quality ‘Adsurance Manager.

The unusual incidents wilthe docimented by the analyst conducting the analysis. The analyst will complete an
"Incident Summary" [fCap/ienlocated on the FB network H: \Worksheets \QA worksheets] for inclusion in the "FB
Incident Log". This iag wi'l be maintained electronically by the DNA Technical Manager. The DNA Technical
Manager will be noticd of any unusual incident, review, and sign off on the summary.

The summary sheet completed by the analyst will contain the following information: The case number(s), analyst

name and ID number, date of summary, date of the incident, and the definition and evaluation of the problem, as
well as its resolution. Supporting documentation, if available, will be provided with the summary.

1.8 PROFICIENCY TESTING

Please refer to the Laboratory Quality Assurance Manual for additional information on the proficiency testing
Program.

Each DNA analyst in the Forensic Biology Unit must complete two proficiency tests in each calendar year with an
interval between the tests of no less than four months and no more than eight months. Both of these proficiency

Implemented 05/7/2018 Issuing Authority: F. Healy, Quality Assurance Manager Page 8 of 70

Printed documents are not controlled



shawnm
Sticky Note
The Supervisor and QA manager will be removed from this process at the next revision of this manual.


o

Unit Policy Manual

Forensic Biology

tests will be external and at least one will involve DNA typing and/or body fluid identification. Analysts that
perform Y-screen testing are considered DNA analysts for proficiency test purposes and will be tested twice a
year using a team approach with a fully qualified DNA analyst. Analysts conducting only traditional screening
testing will be proficiency tested once per calendar year. For DNA proficiency tests, the due date of the
proficiency test (as listed by the test provider) will be the date by which these tests are tracked.

Proficiency tests will be worked in the same manner as casework and undergo both technical and administrative
review. Under no circumstances should analysts compare proficiency test results prior to submitting them for

technical review.

GlobalFiler and Yfiler Plus (for those qualified) must be run on each semiannual proficiency test. Yfiler Plus
testing must be performed on any samples with male DNA. If male DNA is detected in iultiple fractions of the
same samplc (i.e., sperm and non-sperm fractions), Yfiler Plus testing is rcquir(‘A or.only one of the fractions.

Results from the DNA proficiency tests will be submitted to the test provider. “When the results from the test
provider are available, the DNA Technical Manager will compare the r{sult«obtained by each analyst and inform
them of the outcome. Analysts will initial their proficiency test pachcy;, acknowledging the outcome, and the test
packets will be maintained by the Quality Assurance Manager.

1.9 FORENSIC BIOLOGY COMPUTER NETWORK CYSTEM

The Forensic Biology Unit employs an independerit nety 7ork system comprised of several servers and client
computers to share electronic data among crimiralists, link instrumentation, maintain a centralized storage of
data, and provide a secure connection to th¢ Cém'ined DNA Index System (CODIS).

1.9.1 ELECTRONIC DATA S19RAGE
Data backup is perform¢d autonuatically and is managed through the Data Systems Department of the San

Diego Police Depart:zeny, Pliase contact SDPD Data Systems for additional information regarding the
management and s cuiiof the Forensic Biology computer network.

1.10 LITERATURL REVIEW

Analysts within the Forensic Biology Unit will be provided copies of relevant literature (full articles, abstracts, or
miscellaneous publications) periodically throughout the year. Analysts will document their review of the
circulated literature by signing off in the document management system, or on the attached routing slip. This

documentation will be maintained by the DNA Technical Manager.

1.11 QUALITY CONTROL AND CRITICAL REAGENTS

The following list contains the reagents deemed critical to the DNA testing process:
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All reagents used in the extraction of DNA (excluding dithiothreitol (DTT))
Qiagen DNA Investigator and QiaSymphony DNA Investigator Kits

All Quantifiler qPCR Kits

All Autosomal or Y-chromosome STR Typing Kits

Reagents/kits are deemed critical if the improper preparation or production of the reagent/kit could lead to an

analyst failing to obtain a DNA type or obtaining the incorrect DNA type.

1.11.1SAMPLES AVAILABLE FOR QUALITY CONTROL TESTING

Only samples with known DNA profile results will be used to assess critical reagate, Txtraction reagents will
be quality tested using dried blood samples. DNA typing and quantification lats viilibe quality tested using
previously extracted DNA samples.

1.11.2QUALITY CONTROL TESTING OF REAGENTS AN I1S

Before any critical reagent or kit can be used on casework <amries it must be tested in a way that would reveal
any problems with its composition and/or function. All q1alitw/Control analysis will undergo both technical
and administrative review. The genotypes of the positivceantrols, NIST SRM, and known samples must be in
complete agreement with their previously knoy Si'R types. The negative control should yield no detectable
DNA results. If casework analysis using thediew L:eazents or kits is required before final completion of the
technical and administrative reviews, appiro it mist be obtained from the DNA Technical Manager prior to

using the kits.

In the event that the QC data istniacceptable, a second run of the QC samples can be used to demonstrate the
reliability of the reagent o1 kit. !f the cause of any failure is deemed to be reagent or kit related, then the
critical reagents tested w1l iatbe approved for casework and, if applicable, the vendor of the reagent will be

contacted. In-house r¢ igents will be re-prepared and quality tested before use.

The critical reagent./kits will be tested as follows:

Extraction Reagents: Two different known samples and a reagent blank will be carried through DNA extraction
and typing. The preparation dates of the reagents and the results of the DNA testing will be documented on

the Quality Control Worksheet for Critical Extraction Reagents.

Qiagen (EZ1 or QiaSymphony) DNA Investigator kits: Two different known samples and a several concentrated

(note: concentration factor not to exceed 8x) reagent blanks (some eluted in TE and some eluted in water)
will be carried through DNA extraction and typing. The kit, reagent strip lot numbers, and the results of the
DNA testing will be documented on the Quality Control Worksheet for DNA Investigator kits.
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Quantifiler kits: The DNA standard tubes from the new lot of Quantifiler Duo kits should be defrosted, pooled,
and re-distributed into the DNA standard tubes. The new lot of kits should be used to quantify calibrators 1
and 2 from the old lot of kits as well as three replicates of calibrators made with the current lot of kits. Two
samples with known genotypes should also be quantified using the new Quantifiler Duo kit(s), the obtained
quant values should be used to amplify those samples (and appropriate controls) using one of the validated
typing kits. All samples should produce the known genotypes and the peak heights should generally be
consistent with expectations based on the input amount of DNA. The target volume of the QC samples will
be determined based on the quantification value obtained from the new Quantifiler Duo Kit. Successful typing

of the known samples will serve to demonstrate the reliability of the new kit lot(s).

GlobalFiler DNA typing kits: 007 Control DNA should be defrosted, pooled, and i7"t ‘buted into the DNA
standard tubes prior to performing the QC testing. Two known samples wil’ be 1;ped along with the 007

Control DNA positive control and an amplification blank. The lot numbss .f all’kit components and the
results of the DNA testing will be documented on the Quality Contr/sl Warkrheet for GlobalFiler.  (See also
the NIST Testing policy below)

Yfiler Plus DNA typing kits: New kit lots will be tested with ‘ws"known samples, the 007 DNA positive

amplification control, and an amplification blank. The lot aunbers of all kit components and the results of the

DNA testing will be documented on the Quality Control vvorksheet for Yfiler.

All QC data will be stored electronically or'the Friletwork.

1.12 NIST TESTING OF DNA PROCEDURES

Once a year, the DNA typin: procss will be checked against NIST or NIST-traceable standards. Previously
extracted known DNA sambles can be tested alongside NIST SRM samples, thus making them NIST traceable. If
kits are quality controllel using these NIST-traceable samples, this check will serve as the yearly check against
NIST standards.

1.13 PERFORMANCE CHECKS

Performance checks will be performed on the following equipment that has been identified as being critical to the
analysis of samples in the Forensic Biology Unit. The performance of this equipment will be assessed at

approximately the intervals indicated.

A performance check will be performed on any of the instruments listed below if any maintenance, repair, or

service is conducted.
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Equipment Item Location Performance Check Schedule

(approximate)

Pipettes Forensic Biology Main Lab and Every six months

Amplification Room

Balances Forensic Biology Main Lab Every three months

and Amplification Room

BioRobot EZ1s Volume Test Forensic Biology Main Lab Every six months
QIASymphony Forensic Biology Main Lab Every tix months
(cuirently not in use)
Hamilton Nimbus Forensic Biology Main Lab l Eveg six months
|

Thermal cyclers Amplification Room & Every six months
SDS 7500 Amplification Room

Block Contamination Check Every six months
All other calibrations Annually
Genetic Analyzers Amplificatior Roor, Annually
Corbett CAS-1200 Amplif. ~at’on Moom Annually

Pipettes — a performance check olapipcite consists of an evaluation as to the accuracy of the volume delivered

against the selected volume. (A passitig result must be within 5% of the selected volume.

See the equipment mainu/nance protocols section (section 6) for additional information on specific performance

check procedures o1 pravtices.

Genetic Analyzers - the QC analysis of critical reagents will serve as the performance checks of the Genetic
Analyzers. The QC runs performed for the various testing kits employed by the lab will be rotated through the
various Genetic Analyzers throughout the course of the year. Performance checks separate from QC runs may

also be done using a minimum of the amplification positive, amplification negative and allelic ladder.

Corbett CAS-1200 — the performance check of the CAS-1200 will consist of an evaluation of the instruments
pipetting against manual pipetting of the same samples. This will be accomplished based on the CAS-1200
pipetting of a known set of samples for analysis on the genetic analyzer. The results of the CAS-1200 pipetted
samples will be compared against the same samples prepared manually. Total detected peak heights of both sets
of samples will be used to measure the performance of the CAS-1200. The difference between the total peak
heights both sets of samples should be less than 10%.

Implemented 05/7/2018 Issuing Authority: F. Healy, Quality Assurance Manager Page 12 of 70
k Printed documents are not controlled




o

Unit Policy Manual

Forensic Biology

1.14 POLICY FOR MONITORING INCUBATORS, REFRIGERATORS, AND FREEZERS

The incubators, refrigerators, and freezers in the Forensic Biology Unit will be monitored approximately every
week. The operating temperatures should be recorded on a worksheet attached to the equipment. Refrigerators
will be expected to operate at a temperature between 1 to 13°C and freezers at a temperature colder than -10°C.
Consistent deviations from the expected temperature indicate that maintenance or repair is likely required and

the Supervising Criminalist of the unit will be notified.

1.14.1 MICROSCOPES

The microscopes in the Forensic Biology Unit will be maintained according "o pol cies outlined in the

laboratory Quality Systems Manual.

1.15 QUALITY ASSURANCE LOGS FOR THE FORENMsI€"BIOLOGY UNIT

This list below indicates all the logs maintained by the Foreasic Biology Unit:

Log Name Location
Kit Receipt Log C/ Electronic
Reagent Preparation Logs \ Main FB

Supply Order Log N\ Electronic
DNA Extraction & Electronic
Qiagen Robot Reagent 1C Electronic
GlobalFiler QC P Ry Electronic
Y-STR QC Electronic
Quantifiler / Qua_ltﬁiler Duo QC Electronic
Unexpected Results Electronic
pH Meter Calibration Main FB

Balance Calibration Tests Electronic
Pipette Calibration Electronic
Thermal Cycler Calibration & Uniformity Electronic
Ovens & Fridges Temperature Log Electronic
Qiagen EZ1 Volume Test Electronic
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2.0 CASE PACKETS AND REPORTS

2.1 REPORT FORMAT

The Biology Unit will use the standardized report format located in the Quality Systems Manual. Case number,

incident number, and date of occurrence will appear in the report header whenever possible. In addition to the

items listed in the Report Standard Format section of the Quality Assurance Manual, the date of the report will

be included in the initial header and on each subsequent page for multi-page reports. In general, items described

in the report will be limited to those examined or tested. Where available, CII numbers will be included in the

report.

2.1.1

2.1.2

BACKGROUND SECTION

Any references to external data used to render conclusions in th¢ curr¢nt report must be
referenced in the background section, or in the conclusion sactien 11 citing information relating to a
database hit. The use of the background section to providi.2<diional details that may be relevant to
the reader(s) of the report is optional.

CASE-TO-CASE NOTIFICATIONS

When providing information to investigators rgar g links between evidence in different cases,
tabular case-to-case hit notifications will be 1550 d detailing the various cases linked through DNA
evidence. These notifications must b< t¢shnically and administratively reviewed prior to issuance.

Case-to-case notifications will e riquircd when an unsolved SDPD case has been linked through
the database to any unsolved SDFPR fase or any case from an outside agency. In general, case-to-
case notifications will berissued ‘or any newly solved cases linked to previously solved cases with

the same suspect (no nc:ifications are necessary for the previous case(s)).

If a newly analyzed unsclved case is linked to a previously solved case or cases, a case-to-case
notificationwili he i<sued for the new case. The determination of whether additional notifications
will be issued {emthe older cases will depend on case type, the statute of limitations on the old
cases, and/ou the time interval between cases.

SCREENING REPORTS

Screening results can be summarized either through the inclusion of a table or through written
explanations of the results.

2.2 CASE PACKETS

The final packet assembled by the analyst will contain the original of the final signed report, complete

analytical record (or a reference as to where the data is located), and other important administrative

documents (e.g., work requests) for scanning and storage by the Clerical Unit. The final packet is subject to

technical and administrative reviews before the packet is filed.
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Numbering of administrative documents as part of the analytical record will be at the analyst’s discretion.
All additional documents in the case packet (e.g., administrative documents) will be denoted as
administrative document (or Admin. Docs.) and include the case number on the first bound page or on all
unbound pages. Administrative documents should be binder clipped or paper clipped together.

No loose items such as sticky notes (i.e., post-it notes) or photos will be included in the packet. Small items
must be mounted on 8 1/2" x 11" sheet paper. Stickers placed on 8%2 x 117 sheets of paper do not need to
be initialed and dated if they are added on the same day the note page is dated.

If any information is referenced within the analytical record (e.g., a reference sample worked as part of a
different case), a pink sheet indicating that the report relies on information contained within a case packet
from a different case. This sheet will serve to notify clerical that additional material.is required in the event
of a discovery request.

2.2.1 ANALYTICAL RECORD

In general, the analytical record will contain the following:

Chain of custody information
Documentation of relevant communications

Evidence inventory and analysis notes, inc!

uG ngny serology tests results

DNA extraction, quantification, ampiii=ation, and capillary electrophoresis notes
DNA results (elctropherograms)

Interpretation information/wo.kshee s

STRmix results page with iagnosi's information of the MCMC

Statistical evaluations

CODIS worksheets piintouts for any samples to be uploaded to CODIS

Disposition inforriatien for work product

2.2.2 CASEWORK EATCHING
To streamline the adyainistrative burden (case, packet assembly, technical review, and
administritive review) of processing large numbers of cases together, analysts may group the
analytical rczords for multiple cases together into a single analytical record. Each case in the
casewcrl baich should receive its own individual report.

Alternatively, the analytical worksheets common to multiple cases (i.e., extraction through GMID-
X) can be technically and administratively reviewed separate from the complete analytical record.
The technical and administrative reviews shall be documented in the complete case packet, and the
analytical batch only referenced. These analytical batches must be stored on the FB network such
that they are available for review when the complete case packets are reviewed. Please see section
2.6.1 for additional information on technical review.

2.2.3 NOTETAKING
The chain of custody worksheet requires, at minimum, the case identifier, a unique identifier of the
item(s) received, and the date and locations obtained/returned. The Chain of Custody Worksheet
together with the body of the notes must uniquely describe the packaging, condition of the item,
and complete contents of the item received.
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Analysts should avoid using the names of victims of sexual assault or child abuse cases on
worksheets containing information from multiple cases to reduce the risk of the information being
revealed through unrelated cases.

The analyst will take notes with the expectation that they, a technical reviewer, or perhaps an
outside expert, upon review (even years later) will be able to reconstruct what was done in terms

of examinations conducted, testing completed, and any sampling.

Photographs will be labeled with a descriptor unless it is completely evident what the photograph
represents. Photographs should ideally include scale.

Digital photographs taken in the Forensic Biology Unit will be arginved 9o that they can be easily

retrieved, if needed, for discovery. Ata minimum, the electron < files of the photographs should
be saved with the barcode of the item in the file name in a fg!derilabeled with the case number.

2.3 INTERPRETATION OF CONTROLS
2.3.1 SUBSTRATE CONTROLS

For any analysis, a result obtained from a questionc stain is interpreted as being representative of the stain

when the result from the substrate contrsi isncgative.

Results from questioned stains for which the substrate control yields a positive result need to be interpreted
with caution. A result from a quastivned stain may not be representative of the stain when the substrate
control also yields a positive 15ult. “In this circumstance, the results obtained from the questioned stain

need to be considered albng with the results obtained from the substrate control.
Some considerations *or evaluating the substrate control include:

A. The collection of the substrate control. (e.g. Was the control collected from a proven negative area?)

B. Results from presumptive test versus a quantitative test. Was the substrate control originally evaluated
as being negative by a presumptive test, which is less specific than the confirmatory test?

C. Did the substrate control give a low level DNA result versus a considerably higher level DNA result
from the questioned stain?

D. The source of the substrate. Is there a stain on the substrate control, which was not identified
presumptively, which could be giving the result? It may be necessary to examine the substrate for other

body fluids.
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2.3.2 DNA CONTROLS:

Please refer to the Autosomal STR Interpretation Guidelines (or Y-STR Interpretation Guidelines section)
section of the Forensic Biology Technical Manual for the policies regarding the interpretation of the
Reagent Blanks, Positive Amplification Controls, and Negative Amplification Controls.

2.4 CASEWORK REVIEW

All casework performed by the Forensic Biology Unit is subject to both technical and adininistrative reviews.

Refer to the casework review policy in the Quality Assurance Manual.

2.4.1 TECHNICAL REVIEW

Each case packet prepared by an analyst in the Forensic Biology Uaitis subject to technical review by a
second qualified analyst. Technical review will rotate be¢wesn al! qualified analysts in the Forensic Biology

Unit to ensure that the process remains objective.

The purpose of the technical review is to cheg!Ctrit accuracy of the final report and ensure that established
Forensic Biology protocols are being appli<d tcicas” analysis. The final report should adhere to the
established laboratory format (see the Quality Assurance Manual for more information) and the conclusions

in the report must be supported byuthe (ata in the analytical record (case notes, sketches, photos, etc.).

The analytical record serves s tlie vasis for all conclusions set forth in the final report and will be evaluated
in the technical review process. The analytical record will be examined by the technical reviewer to ensure
that it is complete ani suizert Forensic Biology Unit procedures (including interpretation guidelines) and
policies for the exaraination and testing of biological evidence were followed. Any material changes to the
analytical recor tietarfect the interpretation of any result, or the statistics applied to a DNA association,
made as a result ¢ f the technical review, will be kept as part of the analytical record. Analysts must note that

the changes were as a result of the technical review process.

The goal is to have the initial round of technical review completed with a two calendar week period. Any
final review after a file is re-submitted to the technical reviewer should be completed within a few days of
the re-submission. The date of the completion of the technical review will be documented in the report and
in the analytical record. The completion dates of the report and analytical record can be different. It is the
responsibility of the analyst to let the technical reviewer know of any rush status on a case given for review.
It is the responsibility of the technical reviewer to communicate with the analyst if anything (vacation,

training, etc) will delay the completion of the review.
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Unresolved differences between the case analyst and the reviewing analyst can be addressed with the DNA

Technical Manager.

The following list is meant to guide analysts in providing a complete technical review of case packets. The
list is not meant to be all inclusive and a case needs to be evaluated in its entirety to make certain that a

reasonable, competent, and complete analysis was performed.

Analytical Record
All additional materials in case file labeled with “Admin Document”
DNA request has supervisor and/or analyst initials
Notation from supervisor or communication with detective documented for roquested samples
that were not tested
All other requested evidence and reference samples tested
Case file has pink case reference sheet and/or green stat sheet,if apoiicable
Date, initials, page numbers, and case # / incident # on eac) nege
Corrections are lined out, dated, and initialed
Chain of custody exists for all evidence during analys®s it."orensic Biology
If applicable, permission to consume evidence obtaned and/or communicated
All important communications concerning the cas: appcar recorded

Evidence Sampling
There is an adequate description of the s#viaince packaging
There is an adequate written or picteriasrepr 2sentation for evidence examined
There is an adequate written or pittorial representation for samples collected
If applicable, photographs (if affix>d va/page) have proper identifying information
Proper methods were used o locat» biological material
Proper methods were usea <o ilentify biological fluids
Appropriate controle.wi e used for alternate light source and presumptive tests
Substrate controls collected and analyzed where appropriate
Documentaticn j resed that evidence was repackaged and sealed
Sub-item desiziations added to packaging and comments section in FileOnQ
If applicaile "SART Kit Tested" field is updated in FileOnQ

Analytical No.es
Reviewed (TR/AR) Analytical Batch review page present, if applicable
Analytical notes not part of analytical batch contain necessary documentation
If applicable, QA Incident Summary documentation present in notes or in Analytical Batch
Suitable amounts of DNA amplified for evidence and controls for the STR system
Positive Control results acceptable
Amplification Blank (TE) results acceptable
All associated Reagent Blanks have acceptable results

Electropherograms
Appropriate analysis method, panel, and size standard used for all samples
Electropherograms present for all relevant samples
If altered injection times used, controls were injected appropriately

Multiple injections performed where necessary
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Interpretation

CODIS

Report

If multiple injections performed, results generally consistent/ expected

Artifact and allele changes labels appropriately and sufficiently

Loci with common microvariant alleles (X.1 or X.3), have no stutter peaks or alleles above detection
threshold that did not fully resolve from neighboring peaks

Heterozygous peaks in apparent single source samples appear to be balanced

Assumptions regarding number of contributors are documented

Conclusions based on visual comparison are documented

STRmix run for all appropriate samples

STRmix input files imported correctly for evidence samples

If applicable, MCMC conditioned on appropriate references and the text file was imported appropriately
MCMC results appear to have appropriate genotypes, weights, and mixture pronortiins
If applicable, MCMC run with appropriate informed priors

STRmix database search results evaluated for possible staff matches

Comparisons were made to all relevant reference samples and the input i"les e correct
LRs do not have large disparities in results at any loci (i.e., LR = 0 at sy asingle locus)
STRmix diagnostics within reasonable range of values

For Y-STRs, designation of major and minor contributors ‘s apyropriate

For Y-STRs, appropriate comparisons were performed<nd.Conclusions drawn

For Y-STRs, appropriate statistical assessment of evidece oftormed

CODIS sheets present for applicable evidence

If applicable, MME is calculated appropiiatel: for eligibility for SDIS/NDIS

CODIS sheets present for applicale sispects

All CODIS sheets have appropriace car #, item #, contributor %, specimen category, and offense
information

All CODIS profiles have cGirect specimen category and DNA types

Header is correct or first page And correct on additional pages

If applicable, Syppleniantil Report info and Background are appropriate
Evidence exan.inCa Contains correct barcode and appropriate description of items
Evidence (xazincd contains results of presumptive/ confirmatory testing

DNA typing kit(s) listed in Evidence Examined or in Conclusions

Conclusions have appropriate barcode and description (and fraction for diffs)
Conclusion lists number of contributors and mixture proportions, if appropriate
Conclusions include appropriate verbal wording for LR for each contributor

Reported LR for inclusions use lowest HPD for all four populations

Point LR reported for inclusions with no effective sample size, and inclusions with greater than 10°
difference between LR and HPD

Disposition of evidence contains appropriate information

Signature block is correct

Analytical batch(s) listed in report

If applicable, Quality Assurance Incident documented appropriately in report
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ANALYTICAL BATCH REVIEW

The review of an analytical batch (see section 2.2.2) is designed to streamline the reviewed process by not

requiring duplication of data review. The following list is meant to guide analysts in providing a complete

technical review of the analytical material in a batch.

Packet

Date on each page

Initials on each page

Page Numbers on each page

Analytical batch name on each page

Oo|(0|0|0o|o

Corrections are lined out, dated, and initialed

Extraction Worksheets

Appropriate volume of Digest Buffer/ Prot. K (arG DTT)

Correct Preparation date for Digest Buffer/ Prot.:’ (and DTT)

Incubation time 2 required minimum

Appropriate elution volume

TE or dH2O Elution box checked

EZ1 instrument indicated for Cach sa aple

Correct Reagent Strip Lt #

O(0|0|0|0|0o|o|o

Reagent blanks includec

Qntitation Worksheets

Correct Quantifi'r (17uman or Duo) lot #

7500 Insaument listed

Setun Iited

Itast{wMix Preparation was accurately calculated

| “Calitvators are within appropriate range

_TEAmp Blank is under and IPC is green

OO0 |0|0|0|o |0

All reagent blanks are undet and IPC is green

Amplification Worksheets

Correct Amplification Kit (GlobalFileror Yfiler Plus) lot #

Correct TE Prep Date

Thermal Cycler Instrument listed

Setup listed

Master Mix Preparation was accurately calculated

Correct volume for Positive Control (9947A or 007) added

Correct volume for TE Amp Blank added

If samples combined, corresponding RBs are combined

O|0|0|0|0o|o|jo|o|o

Correct volume for Reagent Blanks added
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] Dilutions (and/or) concentration procedures listed below table
10X TE added box checked (if needed)
3500 Sample Setup Worksheets

[m}

Formamide Blank and Formamide ISS included

Ladders included

Positive and negative control included

Reagent blanks included

3500 Instrument listed

Sample setup listed

O|0|0|0|0|0o|o

Correct Reagent Lot #s (Formamide, ISS, Ladder)

GeneMapper Analysis (electronically viewed)

Sample page included in packet

At least 1 evidence and 1 reference ladder passed

All GS600 — Appropriate peak heights and resolution

Positive Control passed
TE Amp Blank (No detected DNA types)
All Reagent Blanks (No detected DNA tyes,

Oo(0o|(0o|o|Oo|d

TECHNICAL REVIEW EXPECTATIONS

The following serves as a further clarificatici of the expectations with regards to the technical review

process should differences of opinian ar:se:

The Analyst and Technital Retiewer will meet in person and have a verbal conversation in an effort to
sort out any differenCes of woinion. Each should have the opportunity to professionally explain their
point of view.

Assuming the/mal /st and technical reviewer cannot come to an agreement; the input of a DNA
Technical Manag=r will be sought.

Should the issucraised in technical review have policy implications, the Technical Manager may need to
consider a pclicy change. In this case, the Technical Manager will work with the Supervising
Criminalist(s) and/or the Quality Assurance Manager to determine the best course of action.
Assuming an agreement between the Analyst, the Technical Reviewer, and Technical Manager cannot
be achieved, the Quality Assurance Manager will be asked to assist the three parties in coming to a
resolution for the technical issue.

Should the technical review issue still remain unresolved the Supervising Criminalist for Forensic
Biology will be informed of the impasse.

Analysts involved in the discussion may elect to have further discussions with the Laboratory Director
concerning the technical issue.

2.4.2 ADMINISTRATIVE REVIEW
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Each case packet prepared by an analyst is subject to administrative review. This review is normally
conducted by the Supervising Criminalist; however, in the event a Supervising Criminalist is unavailable the

administrative review may be performed by another analyst within the section.

The Quality Assurance Manual details the basic elements of the administrative review process. In addition to
those criteria enumerated in the Quality Assurance Manual, the following list is meant as a guide to
providing a complete administrative review of case packets. The list is not meant to be all inclusive and a

case needs to be evaluated in its entirety to make certain that the report and analytical record are complete.

Notes

The chain of custody during testing in the laboratory is documented?

Worksheets are complete?

Report

Conclusions in the report are supported by the data?
Statistical frequencies provided for DNA profiles when avpropriace?

Evidence disposition is summarized?

General

Report and case notes have had a technical review by a qualified analyst?

Analyst has corrected or otherwise resolvcd all concerns raised by the analyst performing the
technical review?

Statistics worksheet summarizing work performed on case (if required)?

CODIS worksheets for appropriace.sanples?

If SART kit is tested, has File-2n-Q has been updated?

2.5 INTERNALLY PROD ICEL' DNA REQUESTS

Introduction:
If an analyst perforn's il analysis on casework in the Forensic Biology Unit, where there are positive findings
for which they will nc: be performing the subsequent DNA analysis, they will submit a DNA request to the

Supervising Criminalist.

If subsequent DNA testing is being requested by an analyst, the screening report will indicate the submission of a
DNA request, and the Supervising Criminalist should be contacted concerning the status of the request.

Guidelines for Request Submission:

If no history is given or multiple suspects may be involved, all potentially probative samples should be forwarded

for DNA testing in order to maximize the potential of obtaining DNA profiles from all offending parties.

A DNA analyst may request further work on unanalyzed items of evidence after obtaining the initial round of

DNA testing results. Any additional work should be coordinated through the Supervising Criminalist.
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DNA analysis of a case is often assisted by the inclusion of the original screening request, microscopy worksheet
pages, or Y-screen quantification results. The number of epithelial cells may also be relevant in certain evidence

and scenarios and should not be overlooked when providing results.

DNA analysts require additional information such as case scenario, consumption issues, reference standard
availability, presence of consensual partners/multiple assailants, and the existence of other evidence that should,
when available, be included on internally produced DNA requests. If only clothing samples are listed in a DNA
request a summary of the screening results from the previously examined SART kit should be included in the

request (if available). The DNA request will document what additional evidence is aveilable in the case.

If a large cutting is necessary to obtain DNA results, multiple cuttings can be placed inzeparate tubes or the
entire stain can be removed and impounded within a freezer packet. This will e d<cumented on the DNA

request.

When liquid blood is being used as a reference sample, between 10,2 5uL of liquid blood should be submitted for
DNA testing. A reference bloodstain card must be prepared i #liis circumstance (suggested sample size = 1mL).
This newly created item must be given a barcode through the Filt*on-Q system and its disposition documented in

the report.
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3.0 EVIDENCE POLICIES

3.1 CASE SUBMISSIONS

The Forensic Biology Unit accepts case submissions from all investigative units with the Department. Case

submissions are handled as described in the Quality Assurance Manual.

Department Order 13-30 requires a consent form when collecting DNA from a subject who is not being arrested
for a felony, is not a 4th waiver subject, or who is not a victim of a sexual assault. The consent form is used to
inform the subject of his or her right to refuse to have a sample collected, and will infor'm the subject that the
sample, if collected, may be entered into a database for comparison with other protiizs. Any reference DNA
sample requested must have a form submitted in order to have the sample ana yzed, unless it has been collected
from a felony arrestee, court order, 4th waiver subject, or sexual assault.rictim. i no form was collected,
permission from the Assistant Chief in the requestor’s chain of commar.d<vili be required to proceed with
analysis. The consent form or documented Assistant Chief approvil w; il be maintained as an administrative

document.

3.1.1 CASEWORK STATISTICS

Casework statistics are recorded for each cascithat 1; analyzed and are tallied in monthly statistics for the

Unit. Supervisors report case statistics {r tlie urit to the Laboratory Manager.

3.2 CONSUMPTION OF EVIDEN CE

General QA Policy:

When possible, sample’s) »7ill not be consumed in testing so that a sufficient quantity is retained for reanalysis. If
the entire sample(s) must e consumed during analysis, the assigned DDA will be consulted whenever possible.
If there is an objectic ¢ to the SDPD lab consuming the evidence, alternative arrangements will be made for the

analysis of the sample(s) in question.

In all cases, with or without a suspect and/or no DDA assigned to the case, a notification will be sent to the
detective informing him or her of the decision to consume the sample(s). Three business days will be given to the
detective to provide an opportunity to respond. The analyst will proceed with evidence consumption in the

absence of'a response.

Discussion:
If the decision of an analyst is that consuming an item of evidence provides the best chance of obtaining a DNA

result and there is an issue with the laboratory consuming the evidence, an analyst may agree to initially consume
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half of the sample (predicated on the subsequent analysis of the remaining portion of the evidence if needed) or

may suggest that an independent laboratory be selected to perform the analysis.

For cases where there is no DDA assigned, the investigators will be informed of the intent to consume the
evidence through an email. For cases without suspects a form email has been created for the purposes of
informing investigators about the consumption of any evidence. The requirement of the email allows for
documented communication.

3.3 UNIT POLICIES FOR EVIDENCE HANDLING

In an attempt to maintain a high level of quality in all aspects of the analyses perfornizd by the Forensic Biology

Unit, the following policies and practices will be adhered to wherever possibl:

3.3.1 GENERAL:

See the laboratory’s Quality Assurance Manual for general‘¢viaince handling requirements.

®  Separate areas are designated within the Unit fonDIMNA extraction, PCR setup, and for the analysis of
amplified DNA. Procedures will be performed in the appropriate area for that analysis.

®  Prior to analysis, the work area mu«t be‘cleaied with a 10-20% bleach solution. The work area will be
covered with clean paper or bench mais. < The contents of items must be inventoried and examined on a
fresh piece of paper. This papercan be used to wrap the item after examination.

e  Allitems examined must T'e marked with a minimum of the barcode and analyst initials. If
circumstances previ nt orforeclude marking the item directly only their proximal containers will be
marked. Any 2dairstip drforrning verifications need only mark their initials on an item.

®  When evidnsco be analyzed is retrieved from the Property Room or Laboratory Vault the condition
of packaging will be noted (i.e., damaged, unsealed, etc). When opening an item, care must be taken
to avoid compromising any information written on the packaging. If possible the original seal will not
be broken. If the contents of the packaging cannot be accessed without breaking the seal, then a
notation will be made in the case notes.

®  An analyst will wear appropriate safety gear and disposable gloves when handling evidence within the
unit.

®  Slides or other derivative evidence generated as a result of analysis are generally given a new barcode in
File-on-Q system, a notation as to final disposition will be made in the notes.
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. Digital images will be taken of most evidence and color laser prints of these images will appear in the
case notes. An archive of all digital images taken by Forensic Biology analysts is maintained on the FB
network.

°

After analysis, items will be returned to the original packaging if possible. The package must be sealed
with evidence tape and the analyst must initial and date the seal. The barcode number must be on the
outer packaging.

®  For any procedure performed in the Forensic Biology Unit only one tube or evidence item should be
open at a time during any sampling and reagent/ DNA addition. Use of any robotics system for sample
setup is an exception to this policy.

o  Within the Forensic Biology Unit there are separate refrigerators anc freez rs dedicated to the storage
of cither reagents or evidence. Evidence and reagents should be stcrecrasparately in their designated
locations while in the Forensic Biology Unit.

.

If an evidence item is swabbed for DNA analysis, a notatics will be made within the File-on-Q evidence

tracking database regarding any sub-designations ass'onsi, or additional associated barcodes created.

3.3.2 CASE APPROACH

® Communication between units is impOrtars in’determining the sequence of examination. A unit able to
individualize evidence has priorityiovat a vait, which can only determine class characteristics.
Destructive examinations will. be carried out as a last resort.

®  The danger of cross-cortamiiution must be recognized and steps taken to prevent it. Evidence
collected from the sspect must not be sampled or extracted at the same time as evidence collected
from the victim. In addit on, case scenario information relating to the locations evidence items were
collected shov!d b considered so that evidence collected from locations associated with the victim are
not extracted with evidence from locations associated with the suspect. The DNA extraction of
evidence ard > clorence standards must be separated by time and/or place.

o Cigarette butts will go straight to DNA analysis prior to any attempt at latent print development.

® It must not be assumed that swabs from the same area packaged separately are equivalent. If body cavity
swabs from a sexual assault kit are submitted in multiple tubes, analysts are obligated to test swabs from

both tubes.

® In general, if a single swab is collected in a Child Abuse case, the swab will be directly analyzed for
DNA in an attempt to preserve as much DNA on the sample as possible. Any decision to initially
consume less than a full swab for non-DNA testing should be discussed with a Supervising Criminalist.
That communication must be documented in the case notes.
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3.3.3 DNA EXTRACTION:

When sampling for DNA analysis a clean cutting surface should be used for each piece of evidence.
Clean scissors or scalpel blades thoroughly with bleach, soap and water, alcohol, or by flaming after
cutting each evidence sample. Alternatively, use a fresh scalpel blade with each evidence sample.

All reagents and solutions will be sterilized where possible. Sterile water and sterile plastics or
glassware will be used for solutions that cannot be autoclaved.

Reagents will be stored as small aliquots to minimize the effects of any contamination events. The lot(s)
of reagents used for each set of analyses will be recorded so that if contaminatien occurs, it can be
traced more readily.

Sterile disposable aerosol resistant pipette tips and sterile tubes yvill e Gsed for any processes involved
in DNA analysis. Pipette tips will be changed between adding and;or removing liquid from evidence
samples.

It is advisable to briefly centrifuge all tubes before ppeiing to remove liquid from the caps.

The number of samples processed at one time should be limited to a manageable number. This
precaution will reduce the risk of a samj‘e mix-up and the potential for sample to sample
contamination. The manageable nuriper of simples will vary depending on the experience and comfort
level of an analyst.

The DNA extraction/ purifisation of questioned samples will be performed separately from the DNA
extraction/ purification Wf »tfesence samples from the same case. This precaution will help to prevent
potential cross-contiminatien between reference and evidence samples. In addition, it is advisable that
DNA extraction/nucifica‘ion of samples, where high amounts of DNA are expected, (references or
large bloodstains)~a.nerformed separately from samples where low amounts of DNA are expected
(single haigzor vary small stains) to minimize the potential for sample to sample contamination.

Only unamplified DNA samples will be stored in the refrigerators and freezers in the extraction area.
No reagents used in the post amplification processes will be stored in any refrigerator or freezer in the
DNA Extraction Area.

At least one reagent blank will be employed for each set of DNA extractions/purifications to check for
possible contamination of the DNA extraction reagents or DNA Extraction Area. A reagent blank is
subjected to all of the reagents and manipulations of the DNA analysis process, but contains no sample.
The reagent blank(s) should be treated in the same manner as the most manipulated evidence sample
associated with it. The reagent blank will be carried through amplification and analysis with its
associated samples. It is advisable to employ multiple reagent blanks in a batch extraction to
accommodate the combining of samples, or the use of multiple DNA testing kits if any samples are
consumed during a first analysis.
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Performing the initial water wash and microscopic examination will be optional for samples that have
previous serological, or Y-screen examinations performed. For reporting purposes, the previous
analysts’ results may be used to document the presence of specific cell types or body fluids.

3.34 QUANTIFICATION

The Quantifiler Duo quantification kit must be used on evidentiary samples derived from sexual assault
cases. Other cases may benefit from the additional information this kit provides and the use of it on
cases other than sexual assault cases will be at the discretion of the analyst.

3.3.5 PCR SETUP:

Use dedicated pipettes for adding kit reagents and DNA to the PCR, tuhes

Add DNA to the PCR tube last. This practice reduces the/pissibility of inadvertent transfer of DNA
between samples and kit reagents. Only one sample trbeisiouidbe open at a time during DNA
addition.

The negative amplification control (no DNA) allovesfor the detection of contamination during PCR
setup.

Avoid touching the inside surface of Wh< tube caps.
Change pipette tips after this addition of each DNA sample.

Store the amplificat’on kits ia the designated reagent refrigerator. Do not store them near extracted
DNA.

3.3.6 POST"AMLYLUIFICATION ROOM:

Only disposable lab coats are to be used in the Amplified DNA Area.

The Amplified DNA Area is dedicated to amplified DNA and should not be used for pre-amplification
purposes.

All surfaces in the Amplification Area should be cleaned with 10-20% bleach solution before and after
setting up samples for analysis. The floor of the Amplification Area will be mopped with a dilute bleach
solution every two weeks.

Caution should be used when handling PCR products to minimize dispersing of the product in the
Amplification Area.
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Always remove the gloves and lab coats before exiting the Amplification Area.
Change gloves whenever contamination with PCR product is suspected.
Use disposable bench paper to cover work areas.

All equipment found in the Amplification Area is dedicated to that area and will never be removed
unless proper decontamination procedures have been employed.

Store amplified DNA in the designated amplified DNA freezer. Under no cincumstances should the
amplified DNA be stored within the DNA Extraction Area.

3.3.7 DNA INTERPRETATION

DNA interpretations must be documented in the analytical recerd.

CODIS sheets for evidence samples must be part of *iie anaitical record.

DNA SAMPLE STORAGE

3.4.1 EXTRACTED DNA

Extracted DNA will be stored oiia short-term basis in a dedicated freezer in the DNA Extraction Area.

DNA extracts should be stoind i3 closed containers or sealed bags.

Extracted DNA wil be stired long-term frozen in the Property Room. A new barcode number must
be created for/extractea DNA samples. All new items in File-on-Q require an incident number to be
assigned. Any nuw incident number assigned to extracted DNA samples will follow the format of:
“ExtDNAar. ~iystrhreeletterinitiasMMDDYY”.

3.4.2 AMPLIFIED DNA

Amplified DNA samples will be stored in a dedicated freezer in the Amplification Area. Under no

circumstances will amplified DNA be stored outside the Amplification Area.

Amplified DNA samples will be maintained for a period of six months from the date of amplification.
After this time, the amplified DNA will be discarded. Care must be taken to avoid contaminating other

areas or evidence with amplified product.
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3.5 POLICIES REGARDING FREEZER PACKETS

Freezer packets are created to store derivative evidence separated or prepared from other evidence that is

customarily stored unfrozen.

Anytime a freezer packet is made for derivative evidence the following information (at minimum) should be

clearly marked:

-Incident number or Case number (if available)

-Barcode number(s) of the evidence contained within

Any derivative evidence (stains, cuttings, or swabs) that will be impounded inea the Property Room as
additional evidence will require the generation of a new item in the barcol's sys.em under the appropriate

incident number. Documentation of the newly generated items should bevincluded in the case notes.

When items that already have a barcode number (or a sub-desigriatiGii from an existing barcode number) are

packaged together, and the packaging is given a new bar{ods'nuriber for the purposes of storage, the

barcode of the packaging is for temporary storage purpcies orid does not become the designator for the items
packaging porary g¢ purp g

inside.
3.6 UNIQUE IDENTIFIERS

General:

Items stored in the Property Rooia 4r Liboratory Vault should have a unique identifier. The barcode number
uniquely identifies each item'stored i the Property Room or Laboratory Vault under the File-on-Q system.
Items stored under the old ysien<will be uniquely identified by the case number (or lab sequence number),
property tag number, an’ item number. Multiple items contained within a single package (e.g., the contents of
a SART kit) should <1l.¢igiven a sub-item designation, which should be noted in the barcode system for that

item.

Any stains, cuttings, or swabs taken of items that will be impounded into the Property Room as additional

evidence will require the generation of a new item in the barcode system under the appropriate incident number.

All items included on a laboratory request to be examined by the laboratory (excluding internally produced
requests) are considered evidence. All cell pellets, extracted DNA, and amplified DNA will be considered the
work product of the DNA laboratory.

During the screening and DNA analysis of evidence it is common to have samples contained in microcentrifuge
tubes. These include question stains, reference samples, cell pellets being preserved for possible DNA analysis,

and extracted DNA. Each sample analyzed within a batch will be labeled with an identifier that will uniquely
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identify it during its analysis. Additional descriptors may be employed to identify particular samples such as “NS”

to identify non-sperm fractions of extracts, or (Y) to denote a Y-screen extract.

3.7 DISCONTINUING ANALYSIS OF SAMPLES

Variables, such as the existence of other probative samples, or the case scenario may affect the decision to
discontinue the analysis of a sample. Quantification information may provide additional insight into the

)

likelihood of obtaining interpretable DNA results, and the decision to discontinue analysis may best be made

after quantification of the sample(s).
In general, analysts may discontinue analysis of samples under the followingcii cums ances:

If a sample contains insufficient DNA to reasonably obtain an interpscrable DINA profile, it may be discontinued.
An analyst may be reasonably sure that the sample has insufficient A" produce a full DNA profile if a large
enough proportion of the sample has been quantified, such thit, Yasea'on the estimated amount of DNA in the
rest of the sample, amplification of the entire sample is unlik:ly ts+"yield an interpretable DNA profile.
Discontinuation of samples is dependent on circumstances oi*he case, as sometimes even limited information

may be beneficial to the investigator(s).

The intent of this policy is to be able to dis¢oninue‘analysis on single samples from items/cases that are unlikely
have enough DNA to obtain a DNA proiite, 'n cases where multiple samples from the same item are collected
for the same purpose (e.g. DNA sample wollected from two different areas on a shirt for wearer information), if

one sample has sufficient DNA add#{onai samples collected for the same purpose may be discontinued.

Touch/Wearer DNA E-ideace
If the amount of total DITA in the extract is less than or equal to £0.0005ng/uL, the samples are unlikely to yield
interpretable DNA 1:eults with the GlobalFiler amplification kit and the sample may be discontinued.

Child Abuse Cases
Prior to discontinuing analysis on Child Abuse cases, the most potentially probative evidence item(s) negative for

male DNA require microscopic examination to confirm no semen is present.

Sexual Assault Cases

If microscopic examination of a sample leads to an estimate that less than 100 total sperm cells are present, the
sperm fraction likely does not possess enough DNA to produce a complete autosomal DNA profile and may be
discontinued. Given the correlation between the amount of DNA in a sample and the likelihood of obtaining

interpretable DNA, the decision to discontinue analysis may best be made after quantification of the samples.
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If the sperm fraction of the sample is probative, both the sperm and non-sperm fractions should be continued

through DNA analysis.

If the non-sperm fraction is probative and sufficient sperm cells are present, both the sperm and non-sperm

fractions must be DNA typed.

If the non-sperm fraction is probative and insufficient or no sperm cells are found in the sperm fraction, only

the non-sperm fraction needs to be typed.

If the non-sperm fraction is not probative, and its sperm fraction contains insufficient or no sperm cells, the

analysis of both fraction can be discontinued.

In sexual assault cases the male DNA is often the probative portion of the samp!= ani the female DNA has little
probative value. In such samples, if the estimated amount of male DN/!is lass than 30pg, the samples are

unlikely to yield interpretable DNA results and the sample may be isjontinzied.

Firearms Evidence

Swabs from firearms generally have multiple swabs for handizr LIVA including both “before” and “after”
processing swabs. If multiple swabs yield sufficient DNA for DNA typing, then all with sufficient DNA will be
DNA typed. If all swabs have insufficient levels ¢t DN# . to reasonably obtain an interpretable DNA profile, the
swabs will be combined for DNA analysis. Ift leastiolie of the swabs has sufficient DNA and the others have an

insufficient amount of DNA, the one(s) wit.; inufficient DNA may be discontinued.

3.8 INSTRUCTIONS FOR PRC 'ESSING FIREARMS FOR DNA

OPTION A: SWABBING 'OrwDNA FIRST

The Forensic Biolog : Janic may process guns for DNA prior to latent print processing. In this instance the
textured areas of the f.rearms such as grips, slide, magazine release, safety, trigger, hammer, cylinder release,
and slide lock(s) will be swabbed. Smooth areas will be preserved for fingerprint processing.

A sticker will be placed on the packaging indicating that swabbing for potential DNA evidence has been done.

OPTION B: FINGERPRINT PROCESSING FIRST

In instances where the majority of the firecarm has smooth surfaces, the Crime Scene Unit will process the

firearm prior to swabbing for potential DNA evidence.
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4.0 CODIS

The Combined DNA Index System (CODIS) is a nationwide forensic DNA database managed by the FBI. It consists
of DNA databases at the local (LDIS), state (SDIS), and national (NDIS) levels. The purpose of CODIS is to develop
investigative leads by matching DNA profiles of two or more samples from these various categories. The database
primarily consists of casework evidence profiles and convicted offender profiles. Sample categories include Forensic
Unknowns (single source profiles), Forensic Partials (single source, but partial profiles), Forensic Mixtures,
Convicted Offenders, Arrestees, Suspects, Unidentified Human Remains, Missing Persons, and Relatives of Missing
Persons.

12" at each locus. Not all

The CODIS software searches for genotypes that are represented by the list of alleles uj o
genotypes represented by the listed alleles may be accepted based on the interpretation f tre evidence. For
example, if four alleles at a locus are submitted to CODIS from a 2-person mixture;thessearch will return hits against
any homozygote genotype represented by the listed alleles. Based on the inferpratasion of a 2-person mixture, any
homozygote genotype would be excluded as a possible contributor, everi'tough<CODIS would return a hit to it. The
case analysts are responsible for determining what is being searched.sn COD15in their assigned cases and what

genotypes would be acceptable at each locus.

Consultation with the CODIS Administrator for searches of compiex mixtures is encouraged. If the CODIS
Administrator is consulted, documentation of the confultativn will be made on the CODIS sheet; however, the
technical reviewer is still mandated to assess the tpesiand Zne sample itself as being acceptable for CODIS. Technical
reviewers will document this review by initialing; ar.d diting the CODIS sheet. Any material changes made to the
CODIS sheet as a result of the technical rewiewsmst be documented. Any material changes made by the CODIS
Administrator after technical review is corplite must be discussed with case analyst and documented within the

analytical record.

4.1 ENTRY OF DNA ?ROFILES INTO CODIS

The SDPD Forensic 3i016gy Unit’s procedures for the entry of DNA profiles into CODIS are based upon the
guidelines outlined in'che NDIS Procedures and the California Penal Code.

Many different situations may be encountered in forensic casework that will influence which DNA profiles, or
what portion of a DNA profile, are acceptable for entry into CODIS. The following are meant as guidelines and

do not cover every possible scenario.

"  DNA profiles selected for entry into CODIS are submitted on forms referred to as CODIS sheets. These
must be technically reviewed to ensure accuracy of the DNA types and specimen category, and acceptability

for CODIS entry. If multiple items from the same case have the same DNA profile, only one CODIS sheet
should be used.
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®  Forensic mixture and forensic partial DNA records submitted to NDIS shall be reviewed to ensure the DNA
records satisfy a statistical threshold for match rarity of approximately one in the size of the NDIS database.

®  DNA profiles (single source or mixtures) from possible perpetrators derived from evidence should be
entered into CODIS, unless that evidence was collected from a suspect. In addition to the general cligibility
requirements for DNA profiles outlined by NDIS guidelines, the suitability of any given DNA profile for
submission to the various levels of CODIS is generally dependent on the discrimination power of the DNA
profile as compared to the number of DNA profiles contained within the given database.

®  DNA profiles or portions of DNA mixtures attributable to victims or elimination reference samples
(boyfriend, husband, etc.) should not be entered into CODIS. Forensic profiles that are ultimately linked to
consensual partners will be removed from the database.

= CODIS sheets should be filled out for suspects that were not matched to an evidenc< Jample or that were
included as possible contributors to a DNA mixture (see section 4.2 for a/iditio; al information on suspect
DNA profiles). These profiles are considered “Suspect Known” DNA protiiess” DNA profile information
will be entered into the local CODIS database (LDIS), also known 1 #4:&SDPD’s local DNA database, for
any suspect (or possible suspect) sample submitted for DNA adaly sis.“These DNA profiles will be
maintained indefinitely within LDIS.

®  Upon confirmation of their status as a suspect by the subniiting detective, “Suspect Known” DNA profiles
will be uploaded to the State CODIS Database (SDif). Suspect Known DNA profiles will remain at SDIS for
as long as they are permitted under SDIS regul>#ians.

" In general, CODIS sheets will be removed fr¢m the case file during the administrative review and given to
the CODIS Administrator for entry. Cénies of CODIS sheets must be retained within the analytical record
as numbered pages.

®  CODIS profiles will be reviewed tur elig.oility, correct DNA types, and appropriate specimen category
prior to upload or search of SDIf.

®  Searches of profiles in th local DNA database may be done prior to technical review of the case file.

4.2 UPLOADING >TSPZECT DNA PROFILES

The passage of Proposition 69 in 2004 allows DNA profiles from suspects to be entered into the California State
CODIS database so long as the individual remains a viable suspect in the case for which their sample was
submitted. The proposition states that DNA profiles from suspects must be removed from the State CODIS
database after two years unless written documentation that the individual is still a suspect is received by the State
CODIS Administrator from the agency submitting the suspect DNA profile. Written documentation must be
submitted to the State CODIS Administrator every two years for a suspect profile to remain in the State CODIS
Database. The SDPD laboratory will remove suspect DNA profiles from the State CODIS Database when a
profile has been in the State CODIS Database for a period of two years. Should a suspect with their profile
entered into the State CODIS Database be eliminated as a suspect in the case for which their sample was

submitted, the DNA profile from that individual will be removed from the State CODIS Database.
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All reference samples collected from juveniles (17 years and younger at the time of collection) will be submitted
into the SDPD’s local DNA database identified as juveniles by specimen category. DNA profiles from juveniles

will be removed permanently from the local database after two years.
Procedure for Uploading/Removing Suspect DNA Profiles from the State CODIS Database

1. For each suspect DNA profile entered into the SDPD’s local DNA database a form letter will be sent to the
case detective. This letter requests the detective indicate whether or not the person in still considered to be
an active suspect in the investigation.

2. If the detective indicates that the person is considered to be an active suspect, thetsuspect’s DNA profile is
uploaded to the State CODIS Database.

3. After two years the suspect’s DNA profile is removed from the State COIDIS Latabase.

4. Form letters documenting active suspect status will be maintained for the ('nrat.on of the profile remaining

in the State CODIS Database.
Procedure for Uploading/Removing Suspect DNA Profiles fror tie’sSDrFD’s Local DNA Database

1. DNA profiles generated from adult suspects who are (1 arrésted for a felony, (2) subject to conditions
associated with fourth waiver status, (3) mandated by a court order to provide a DNA sample, or (4)
consent to the collection of their DNA by sighing a SDPD Consent Form will be entered into the Local
CODIS Database.

2. All adult suspect DNA profiles will remain for five years in the SDPD’s local DNA database.
Procedure for Uploading/ Remaviis Suspect DNA Profiles from the SDPD’s Local DNA Database

DNA profiles generated tro m juvenile suspects (17 years or younger at the date of collection) who are (1)
arrested for a felony, (2) ‘ubject to conditions associated with fourth waiver status, (3) mandated by a court
order to provide a DMA sample, or (4) consent to the collection of their DNA by signing a SDPD Consent Form
will be entered into the Local CODIS Database.

On a monthly basis, DNA profiles from juveniles that have been in the database for two years (from the date the

profile was entered) will be removed.
4.3 DATABASE SEARCHES AND MATCHES

Searches of the SDPD’s local DNA database can occur prior to technical review and are also performed at the

time of the entry of the profile into CODIS. Searches of the state database are performed by the state (California
Department of Justice). Searches of the national database are performed by the (FBI) laboratories. DNA profiles
are uploaded to the state database at least once a week to coincide with database searches and with the uploading

of DNA profiles from state to national databases.
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Periodically, information contained within the SDPD’s local DNA database (SDPD’s LDIS) may be shared with
accredited forensic DNA laboratories in other jurisdictions. Similarly, information from the LDIS of accredited
laboratories from other jurisdictions may periodically be shared with our laboratory. In these instances, a “batch
file” containing the information within LDIS will be provided for the purpose of comparing DNA profile
information between jurisdictions. When the SDPD Crime Laboratory receives a batch file from another
agency, the batch file is used for a search against LDIS. The data from the external agency is not stored with the
SDPD’s LDIS and ownership of the data is retained by the agency from which it originated. It is the
understanding of our laboratory that outside agencies will take the same approach with our LDIS information.

£alensic hits and offender

There are two basic types of database matches that could provide an investigative 133
hits. Forensic hits involve the matching of Forensic Unknowns from two cases. Oi‘ender hits involve the

matching of a Forensic Unknown to a Convicted Offender.

Any potential database matches will be evaluated by the CODIS Addinistzatir (or designee). In general, if the
SDPD sample matching in CODIS is from an unknown source, the siaten will be evaluated for “goodness of fit”.

If the potential match is deemed to be good, at that time the ‘otiication process will be allowed to proceed.

The “goodness of fit” of any potential database match will be Gependent on the specimen category. In general,
potential matches between forensic unknowns an‘t any :ample in a single source sample index (e.g., convicted
offender) will be assessed visually. Potential riatcheshctween a mixture or partial DNA profile and any sample
in a single source sample index will be asses:ea through a likelihood ratio. The likelihood ratio will generally
assess the probability of the evidence giveinth: DNA profile from the putative match is a component of the
mixed or partial DNA profile searche! agrinst the probability of the evidence given the DNA profile from the
putative match is not in the mixved i partial DNA profile searched. In general, the likelihood ratio results used
for the assessment will be the lowc;t 99% 1-sided HPD value for the four population groups. Likelihood ratio
results greater than fift:"tin’ es tiie size of the relevant database in these comparisons will be declared as offender
or forensic hits. Likelihocd ratio results between ten and fifty times the size of the relevant database will be
further reviewed to !<termine if the putative associations will be reported. The likelihood ratio results used to
assess forensic and oftender hits will be retained electronically (G:\Misc DATANCODIS\CODIS Matches). If
the database LR results are sufficiently high (1.0x10"" or greater), it may not be necessary to perform an LR with
HPD calculation as the value considering the HPD is unlikely to be less than the likelihood ratio threshold.

The matching of two evidence samples known or suspected to be from the same person is referred to as a
benchwork match. When an evidence sample has already been linked to a suspect and then matches the same

person who is in the database as a Convicted Offender sample, this is referred to as a conviction match.

Information regarding forensic and offender hits must be included in at least one report. Prior to a match report
being written, investigators may be contacted regarding DNA matches. However, care must be taken to

communicate the information accurately, and any significant communication should be documented on a
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communication log. Prior to releasing the information to an investigator, the results should be reviewed by a

second analyst and the review documented in the notes.

4.4 MAINTENANCE OF A STAFF INDEX IN CODIS: SAMPLES FROM LABORATORY EMPLOYEES
AND INTERNS

Section 2.9 in the Quality Assurance Manual addresses this database. The following are the rules for the

collection and analysis of these samples:

1. A SDPD Reference Mouth Swab Kit will be used to collect two swabs from tha.individual. The Quality
Assurance Manager will coordinate sample collection and coding of the sapipic

2. SDPD Reference Mouth Swab Kits from Staft and Interns for which pexm:ssion ‘o retain has been obtained
will be archived with the Quality Assurance Manager.

3. The samples to be analyzed by a qualified DNA analyst following:the pro.ocol used to analyze reference
mouth swabs in casework.

4. The DNA Technical Manager or CODIS Manager will reviey the analysis and enter the DNA profiles in the
Staff Index of the SDPD’s local DNA database.

5. The electropherograms and CODIS printout will be maixtained for each sample.

4.5 REPORTING DNA RESULTS ASSQCIATFED TO THE ELIMINATION DATABASE.

When an evidence DNA profile is found to match or potentially be associated with a profile in the elimination

database, the following will be déne

The CODIS match detailigncut «r first page of the STRmix Database Search report indicating the match to the

coded sample from the ¢linination database will be included in the analytical record.

If the DNA profile in"the case was found to match (or the mixture includes) DNA from any elimination profile in
the database, the report will state DNA from staff was found to be associated with the DNA profile in the case.
The report will also address whether any interpretations were affected by the presence of this DNA.

A Staft Match Summary Sheet will be completed detailing the match and will include the coded sample number

from the elimination database that matched to the evidence.

The Staff Match Summary Sheet will be submitted to the DNA Technical Manager and will be routed through the
Quality Assurance Manager. For any association where the HPD LR is above the limited support category, the

Quality Assurance Manager will conduct further inquiry into the root cause of the contamination.

4.6 OUTSOURCING
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In order for the SDPD Crime Laboratory to accept outsourced data for the purposes of searching the CODIS

databases the following criteria must be met prior to the initiation of analysis by the vendor laboratory:

The vendor lab selected for the analytical testing must be accredited and the documentation of that
accreditation, including the vendor laboratory’s latest external audit report including responses and follow-
up must be provided to the SDPD Crime Laboratory.

Prior approval by the DNA Technical Manager of the technical specifications of any DNA analysis to be
performed by the vendor laboratory is required.

For any new outsourcing agreement an on-site visit to the vendor laboratory by the DNA Technical
Manager, or another qualified analyst, is required.

4.6.1 ON-SITE VISITS TO VENDOR LABORATORIES

For any new outsourcing agreement, the DNA Technical Manager;or anotaer qualified (or previously
qualified) analyst designated by the DNA Technical Manager ar Zvpervising Criminalist, will perform an on-

site visit of a vendor lab prior to the initiation of analysis 0i th« outsourced samples.
An on-site visit to a vendor laboratory shall include at a miz mum:

®  An evaluation of the laboratory facilities to,enwie the integrity of the evidence will be maintained while in
the custody of the vendor lab.

®  An evaluation of the procedures e they relate to ensuring minimal loss or contamination of the evidence
while in the custody of the vendor: lab.

®  An evaluation of any Corrtctive Actions taken by the laboratory in the previous six months prior to the
on-site visit.

" Aninterview with.the wend'r laboratory’s DNA Technical Manager or laboratory analyst.

The on-site visit (v:'l be'documented in a report that will be maintained by the DNA Technical Manager.

If an outsourcing agreement with a vendor lab is continued from one year to the next, then an on-site visit to
the vendor laboratory by another NDIS participating laboratory using the same technology, platform, and
typing test kit may be used. Documentation of the on-site visit by a second NDIS participating laboratory must
be obtained by the SDPD Crime Laboratory before any new analysis is initiated in the new year of the

agreement.

4.6.2 REVIEW OF OUTSOURCED DATA

Prior to uploading outsourced data into the databases of the Combined DNA Index System (CODIS) a
technical review of the data will be performed. The review of the data will be performed by a qualified (or

previously qualified) DNA analyst and will be documented and include:
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® A review of the analytical record to include all controls (ladders, positive and negative amplification

controls, and blanks.

® Areview of the vendor laboratory’s final report to ensure that the results/conclusions are supported by

the data, and that each tested item (or its probative fraction) is addressed.

®  Areview of the data for all submitted samples to the vendor laboratory.

® A verification of the DNA types, eligibility, and correct specimen category of any sample to be uploaded
to the CODIS databases.

4.7 REINTERPRETATION OF LEGACY AMPLIFICATION KIT DATA

According to the FBI Director’s Quality Assurance Standards for DNA Testing Laboratoizextardard 13 states, an

analyst can only interpret data generated by the amplification test kit in which Yic oxstiz is currently proficiency

tested, therefore if the analyst is not currently proficiency tested in an amplific tion/(est kit previously used by

the laboratory (i.e., a legacy amplification kit), the analyst cannot reint/rpret tie legacy data.

This policy is intended for situations when an analyst is required t& re’~terpret data generated with legacy

amplification test kits for a comparison made to DNA profiles‘gereraied with amplification test kits in current

use.

Reinterpretation of legacy data may occur in accordsnce with the following:

1.

If an analyst is currently qualified i1 ar atipification test kit (trained and proficiency tested), and the
analyst was previously qualified “trefned/and proficiency tested) in the legacy amplification test kit,
the analyst can reinterpret tiza legicy data if the analyst has been proficiency tested on the legacy test
kit within the last two ca'endar years. If an analyst has not been proficiency tested on a legacy test kit
within the last two ca'endaryears, then the Technical Leader must document and approve the
completion of theanalysi’s review of the validation data and standard operating procedures of the
legacy test kit. If in ana yst, who has completed the requirements to interpret legacy amplification
test kit datahas not reviewed the required documents within the last two calendar years, the
Technical Lea ‘er must document and approve the completion of the analyst’s additional review.

If an analy. t is currently qualified in an amplification test kit (trained and proficiency tested), but has
never been previously qualified in the legacy amplification test kit, the analyst can reinterpret the
legacy amplification test kit data if the analyst is trained in the legacy test kit interpretation protocols
by a previously qualified analyst. The review of the validation data and standard operating procedures
of the legacy test kit, training by the previously qualified analyst, and interpretation competency test
must be completed by the analyst, and documented and approved by the Technical Leader.
Documentation shall contain sufficient information for an auditor to confirm the analyst is qualified to
reinterpret legacy amplification test kit data.

If a previously qualified analyst is unavailable to train a currently qualified analyst on a legacy
amplification test kit, it is highly recommended that the current analyst not reinterpret legacy data.
However, if the current analyst must perform legacy interpretation without training from a
previously qualified analyst, then it is reccommended that the currently qualified analyst and Technical
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Leader train in the legacy test kit interpretation protocols, review validation data and standard
operating procedures. The training and interpretation competency test must be completed by the
analyst, and documented and approved by the Technical Leader. Documentation shall contain
sufficient information for an auditor to confirm the analyst is qualified to reinterpret legacy
amplification test kit data.

4. Ifalaboratory generates new interpretation protocols from legacy validation data (e.g., developing a
stochastic threshold when none previously existed), the laboratory shall document the basis for the
new interpretation protocols. These new protocols shall be documented in the laboratory’s standard
operating procedures and memorialized in the Quality Assurance Standards Audit Document. The
training and interpretation competency test must also be completed by the analyst, and documented
and approved by the Technical Leader. Documentation shall contain sufficiert information for an
auditor to confirm the analyst is qualified to reinterpret legacy amplification test kit data.

Technical reviewers of reinterpretations of the legacy data are held to the samc trajring requirements as the

analyst reinterpreting the data.
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5.0 LABORATORY MAINTENANCE

5.1 GENERAL LABORATORY MAINTENANCE

All members of the Forensic Biology Unit are responsible for the general upkeep of the laboratory including
stocking supplies, washing dishes, and cleaning common areas. Protective gloves, safety goggles, and a
laboratory coat should be worn when handling chemicals and cleaning lab instruments. The following tasks are

completed each week:

®  Monitor the operating temperatures of all freezers, refrigerators, and incubators. Log temperatures on the
log sheets. When a sheet has been completed, it should be scanned into the FB network and moved to the
appropriate folder within the QA-QC folder. The scanned sheet should be savpd.nsiag a file name that
clearly indicates what the log is for.

®  Wipe general use counters with 10-20% bleach solution.

®  Clean common use centrifuges with 10-20% bleach solution iall<vwed by wiping with distilled water.
®  Wipe hoods with 10-20% bleach solution (do not wipe plastis’doors).

®  Clean interior and exterior of drying boxes with 13-20% bleach solution.

®  Wash glassware and dishes not belongitig 5 ansinalyst (analysts are responsible for their own dishes).
Return washed dishes to their appranria ‘e storage location.

e  Fill distilled water carboys, 1sagentalcohol bottles, 10-20% bleach solution bottles, and Liquinox detergent
bottles.

The above tasks apply {5 a'ivwoms of the Forensic Biology Unit. Every two weeks, the Amplification Room
floor will be moppcawith'10-20% bleach solution. Record the completion of maintenance tasks in the Main

Forensic Biology Uni. Maintenance Log, and Amplification Room Maintenance Log.

5.1.1 Glassware Washing

It is the responsibility of each analyst to wash their own dishes. Protective gloves, safety glasses, and a lab coat

or apron should be worn.
1. Wash glassware in warm water with Liquinox detergent.
2. Rinse detergent from glassware by rinsing in tap water.

3. Rinse each piece of glassware in distilled water.
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4. Set glassware to dry.
5. Return glassware to appropriate storage location when dry.

Note: The most critical concern about glassware in the DNA Laboratory is that glassware in the Amplification
room and glassware from the DNA Extraction-PCR Setup Area be kept separate. The use of glassware
dedicated to the Amplification area in the DNA Extraction-PCR Setup area is far more serious than the
reverse. The only circumstance in which glassware may be transferred from the Amplification Room to the
DNA Extraction-PCR Setup Area is if the glassware has been treated with bleach for 30 minutes followed by

autoclaving.

5.2 CLEANING LOGS

The following cleaning logs will be maintained by the Forensic Bioloav iit. | They are intended to ensure
common use areas are kept in a clean state. Any cleaning should e er*ared electronically into the FB cleaning

log excel workbook.

Cleaning Log Location Updated
Forensic Biology Main Lab Electr(,,*ic_ Weekly
Amplification Room El-tronic Weekly/ Biweekly (floors)
Qiagen BioRobot® EZ1 El: ctr;nc Monthly
1

5.3 CLEANING AND DECONTAMINATION PROCEDURES

Squirt bottles containing diluce bleach solution (10-20%) are present in the different work areas in the DNA
Laboratory. Following ®NA extraction, PCR setup, or preparation of amplified DNA samples the work areas
that were utilized wili be thoroughly washed with the bleach solution making sure the entire work areas are

treated.

If lab bench paper has been laid down and is thought to be contaminated with DNA, the lab bench paper should
be disposed of.

Racks or glassware thought to be contaminated with amplified DNA will be treated in the manner described

below.

For items that cannot be autoclaved, they will be soaked in 20% bleach for 30 minutes, rinsed thoroughly with

tap water, rinsed in distilled water, and allowed to air dry.
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For items that can be autoclaved, they will be treated first with bleach as previously described and then

autoclaved for thirty minutes.

5.3.1 DECONTAMINATION OF CENTRIFUGES

In general, any removable part of a centrifuge can be cleaned with detergent and water, rinsed with distilled
water, and allowed to dry. If a serious contamination problem occurs (i.e. spilled extracted or purified DNA),

the rotor should be rinsed in a 10-20% bleach solution, rinsed with distilled water, and allowed to dry.

The metal tubes used with the Sorvall centrifuge should be cleaned with detergent and water after each use.

The metal rotors and tubes the Sorvall centrifuge can also be autoclaved.

5.4 DISPOSAL OF HAZARDOUS WASTE

There are six waste streams within the Forensic Biology Unit that “hewidbe handled as hazardous waste.

These are as follows:

5.4.1 PHENOLPHTHALIN CONTAMINATED SWAR'
Phenolphthalin contains ethanol and swibs ;ontaminated with it will go into appropriately

labeled waste buckets. After the syiabshave dried the swabs can be disposed of in the

regular trash.

5.4.2  PHENOLPHTHALIN AYD ' MG LIQUID WASTE

Phenolphthalin and L24G/Aquia waste contains zinc; a heavy metal. The unusable liquid
waste will be stortd n ttiz Chemical Storeroom for disposal. The bottles should be
appropriatelyleheliad vith the hazard (flammable for pheno and corrosive for LMG). The

zinc contained i voth reagents should also be noted on the log.

5.4.3  QIAGEN REAGENT WASTE (EZ1 or QiaSymphony)
EZ1 strips are flammable because of the ethanol they contain and should be placed in the
designated waste containers by the instruments. All tips, tip holders, and tubes can be
disposed of as regular trash. When the EZ1 strip waste containers are full the waste can be
transferred to the Chemical Storeroom for disposal. Liquid QiaSymphony waste can also be
transferred to the Chemical Storeroom.

5.4.4 PHENOL-CHLOROFORM-ISOAMYL ALCOHOL WASTE
Phenol-chloroform-isoamyl alcohol is an organic solvent and the liquid waste goes in the red
waste containers in the hoods. Tips and tubes contaminated with phenol-chloroform-
isoamyl alcohol should be allowed to evaporate in the hood. After evaporation the plastic
ware can be disposed of in the regular trash.
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5.4.5 FORMAMIDE WASTE
Formamide is a known teratogen and the formamide waste will be disposed of in the waste
bucket in the amplification room. When full the waste can be transferred to the Chemical
Storeroom for disposal.

5.4.6 BIOHAZARDOUS WASTE
Large volumes of liquid blood are biohazardous. Any large volumes of blood and the
materials used to clean them up should be disposed of in red biohazard containers.

547 NON-HAZARDOUS WASTE
Small volumes of blood that will dry within a reasonable amount of time canhe disposed of in the
regular trash. LMG test swabs can be disposed of in the regular trashe= Al vlasticware [tips, tubes
(including microcon/ centricon tubes), transfer pipets, etc] and glo zes cali be disposed of in the
regular trash. Acid phosphatase test swabs can be disposed ofin thiy regular trash and any waste liquid
down the drain.
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EQUIPMENT MAINTENANCE PROTOCOLS

6.1 USE AND MAINTENANCE OF THE WATER SYSTEM

The ultra/nano pure system uses the distilled water reservoir as its water source.

Ultra pure water

The Barnstead NANOpure ultra pure water system removes ions from water. It is meant to be used with
pretreated water. Hence, the water used is first distilled. The system can be set to three different modes: off,
standby, and on. The system is left on standby when not actively in use to allow weter to be circulated
through the cartridges for five minutes out of every hour. This extends the life ¢“+he cartridges. When ultra
pure water is needed, set the system to the on mode by pressing the ‘ON/STANDLY/OFF button until a
numerical value appears. This number represents a resistivity measurement of the water, which indicates its
purity. Wait for the number to increase to at least 18.0 before dispesising. i€ this number remains below
18.0, then the cartridge is no longer efficiently deionizing the wa#<i, A carboy is used to collect and store
ultra pure water, as the system produces purified water rather siarv1y.“The ultra pure water system should
never be used when the distilled water reservoir is empty.<A Jow water protection device has been built into

the distilled water reservoir to prevent the ultra pure watcr sysiem from operating when the still is low.

6.2 OPERATION OF THE pH METER

Thermo Scientific Orion Star A111 pH“ete: Operation

Electrode Preparation

Gl AW N =
Jte

N o

Disconnect electrode froin meuor.

Uncover the filling hole“:nd acd electrode filling Ag/AgCl solution.

Solution must be 2%ovs reference junction and at least one inch above sample level.

The filling hele m st be open when electrode is in use and closed when in storage.

Place the electrod< urthe electrode holder and suspend it in air for 5 minutes so that the solution in the
clectrode can thoroughly wet the reference junction.

Shake electrode downward (similar to a thermometer) to remove air bubbles.

Soak electrode in pH electrode storage solution for 30 to 60 minutes.

Connect electrode to meter.

Electrode Storage

1. Short-term Storage (up to one week)
a. Soak the electrode in pH electrode storage solution.
b.  To prevent crystallization of the fill solution, cover the fill hole whenever the electrode is being stored and
open the fill hole when calibrating and measuring.
2. Long-term Storage (more than one week)
a. Fill the reference chamber and securely cover the filling hole.
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b.  Cover the sensing element and reference junction with the protective cap/sleeve containing a few drops
of storage solution.
c.  Before returning the electrode to use, prepare it as a new electrode.

Electrode Maintenance

1. Inspect the electrode for scratches, cracks, salt crystals.
2. Rinse off salt crystals with DI water.
3. Drain the reference chamber, flush it with fresh filling solution and refill the chamber with fresh filling

solution.

Electrode Cleaning
1. Soak electrode in 0.1 M HCL or HNO3 for 30 min.

a. Can also be soaked in a 1:10 dilution of household bleach mixed with het water (stir at fast rate).
2. Drain the reference chamber and refill it with fresh filling solution.
3. Soak the electrode in pH electrode storage solution for at least 1 hour.

Calibration

Prepare the electrode according to the electrode preparation wast Getions.
Connect the probe to the meter and turn on the meter.

Press mode to display pH for the pH measurement mce.

Select 2 pH buffers that bracket the pH you are targcting

Press Cal

Rinse the electrode in DI water and blot witi.a kim wipe.

Place electrode into first buffer.

Wait for “Ready” then record value i ¢z beOk.

Rinse the electrode in DI water an&hlot with a kim wipe.

O 00 ~J O\ U1 B W N —

—_
=]

. Place electrode into second bufi-r.
11. Wait for “Ready” then receérd/aize m log book.
12. Rinse the electrode in D¥waterand blot with a kim wipe.

Measurement

1. Perform Calibration :teps first.

2. Make sureitisin phmeasurement mode.

3. Press measure: he meter will immediately start taking readings.

4. When “Ready” is displayed the meter stops measuring the pH, so you may need to press measure
multiple times when pH-ing the solution.

5. When you reach the target pH rinse the electrode in DI water and blot with a kim wipe.

6. Turn pH meter off.

Store electrode according to the Electrode Storage directions provided.

6.3 OPERATION OF THE AUTOCLAVE

The autoclave is used to sterilize critical reagents and equipment via steam pressurization. There are two exhaust
selector settings on the autoclave: FAST (Instruments) and SLOW (Liquids). Use the slow setting when only

liquids or liquids and equipment are being sterilized. If sterilizing equipment use the fast setting.
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1. Close the drain valve.

w N

loosely.

N

immediately after sterilization is complete due to the high heat and pressure; allow to cool and depressurize.

6.4 BALANCES

Balances and microscopes in the Forensic Biology Unit will be maintaingdand the calibration checked according

to policies outlined in the laboratory Quality Assurance Manual. Lakaraiory balances are calibrated by an outside

Set the time for 30 minutes.

company once a ycar.

Forensic Biology

Fill with autoclave with approximately 5.5 liters distilled water and 0.5 liters tap water.
Load autoclave with items to be sterilized. Place autoclave tape on lids, if necessary, and be sure lids are on

Close autoclave door. Be sure the door closes tightly. If not, adjust the screw below the door handle latch.
Set the exhaust selector to “Fast or Slow”, depending on the items being sterilized.

When the sterilization is complete, carefully open the door and drain valve. Do not open the autoclave

The calibration is checked every three months by the Laborator Technician. Balance calibration is checked by

weighing various NSB certified weights, given in the tablesseiow. The acceptable range of variation is 1% from

the true value for weights less than one gram, and 5% :om true value for weights greater than one gram.

If a balance is found to be out of calibration 1uias t« be sent to an outside company to be recalibrated. Once

returned, the calibration of the balance«will checked by the Laboratory Technician before use in the laboratory.

Pan Balance
Analytical Balange
Weight Acceptable R
Weight (g) | /¢eeptahle Range (g) eight (g) ceep a( )e ange
g

0.01 (.0099 - 0.0101 1.00 0.95-1.05
0.05 0.0495-0.0505 5.00 4.75-5.25
0.10 0.0990-.0.1010 10.00 9.50-10.50
0.50 0.4950-0.5050 50.00 47.50-52.50
1.00 0.9500-1.0500 100.00 95.00-105.00
5.00 4.7500-5.2500 200.00 190.00-210.00
10.00 9.5000-1.0500

50.00 47.5000-52.5000

100.00 95.0000-105.0000
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6.5 MAINTENANCE OF THE QIAGEN EZ1s

Each month the piercing units are cleaned and the O-rings are greased on the Qiagen EZ1 robots. Maintenance
actions are recorded on the Qiagen EZ1 Maintenance Worksheet in the Qiagen EZ1 Maintenance Log. A
volume test is conducted every six months to monitor the pipetting accuracy of the robots. Results of the

volume test are recorded on the BioRobot EZ1 Volume Test Worksheet in the Qiagen EZ1 Maintenance Log.

6.5.1 CLEANING THE PIERCING UNIT:

The piercing unit cleaning protocol can be accessed using either the DNA Investigator Card or the Volume
Test Card. If only a cleaning is required, use the DNA Investigator Card; if a volime test is also due, then use
the Volume Test card. This will limit the number of times the machine is turiic oiand off and cards are
switched. Never remove or insert a card when the machine is on. The ' NA Investigator Card

should always be in the machine so that it ready for use.

1. With the robot off, insert the Volume Test Card or ensure tha{ i DNA Investigator Card is in the card
slot.

2. With the door closed, turn the machine on.

3. Press 1. Protocols.

4. Press 3. Clean piercing unit. The piciging unit will move forward and downward.
5. Open the door by lifting up, at 4 civan the piercing unit with reagent alcohol.

6. Close the door and pr >ss Es = when finished.

6.5.2  GREASING " HE O-RINGS:

Apply a small amouat of silicon grease to the top of a filter tip and use it to apply the grease to the tip adapters.

Wipe off any excess grease with a tissue.

6.5.3 VOLUME TEST:

The volume test requires the use of the Volume Test Card.

1. With the machine turned off, insert the Volume Test Card.

2. For cach robot to be tested, individually number and weigh six empty clution tubes with caps. Record the
weight of the empty elution tubes on the BioRobot EZ1 Volume Test Worksheet in the Qiagen EZ1
Maintenance Log.
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3. Place the six empty elution tubes, without their caps, in row 1.

4. Place six sample tubes containing ImL of distilled water in row 4.

5. Place six tips in tip holders in row 2.

6. With the door closed, turn the machine on.

7. Press the Start button. The volume test will begin.

8. When the test is complete, press Esc to exit the protocol and turn the machiie or.
9. Remove the Volume Test Card and insert the DNA Investigator Cara:

10. Replace the caps on the elution tubes and remove them fror<'tt,> masline.

11. Weigh cach tube, now filled with approximately 500 {1 < distilled water.

Record the weights of the water on the Volume Test Worlzheet and calculate the variance. Allowable
variance is within 5% of the volume pipetted. Tor tti> 500uL pipetted in the volume test, the allowable range
is 474 to 525 uL. Recall that 500uL is equalto 500rig.

6.6 HAMILTON NIMBUS 4 MAINLENANCE

The Nimbus requires routin¢ mainteiance to be performed daily, weekly, and semi-annually in order to ensure
optimal performance. Ady maint‘nance failures should be reported to Hamilton Technical Support (1-800-648-
5950) for troubleshootii assistance.

Daily Maintenance:

The daily maintenance should be performed prior to the first run of the day. It is not necessary to perform the
daily maintenance prior to subsequent runs if it has already been performed on a given day. It is also not

necessary to perform the daily maintenance on days the Nimbus is not used.
1. Power on the Nimbus instrument and attached computer.

2. Open the Maintenance software (on the desktop).

3. Select the “Daily” maintenance type and click “Run Maintenance”.

4. Inspect deck and carriers for cleanliness.
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a. Clean the deck with deionized water and/or ethanol.
b.  Wipe the o-rings on the channels with deionized water.
c.  Check the “Inspect deck and carriers for cleanliness” box.

5. Empty Tip Waste/Liquid Waste.
a. Remove the tip waste receptacle and empty tips into trash.
b. Replace plastic trash bag in tip waste receptacle if needed.
c.  There is no liquid waste to empty.
d. Check the “Empty Tip Waste/Liquid Waste” box.

6. Select the “Check tightness of Pipetting Channels” box.
a. Read the message that appears, remove the tip eject plate, close the doorgand click “Continue”.
b.  The system will automatically test the o-ring seals of the channels.
7. Select the “Check LLD” box.
a. Read the message that appears, ensure the tip eject plate is stil.=¢mcved and the door is still closed, and
click “Continue”.
b.  The system will automatically test liquid level sensing
8. Click “OK” to acknowledge that the maintenance has complcced successtully.

9. Replace the tip eject plate.

10. Click “Close”.

11. Exit the Maintenance software.

Weekly Maintenance:

The weekly maintenancs siouid be performed once a week regardless of whether or not the Nimbus is to be

used that week.

1. Power on the Nimbus instrument and attached computer.
2. Open the Maintenance software (on the desktop).
3. Select the “Weekly” maintenance type and click “Run Maintenance”.

4. Clean deck and carriers.
a. Clean the deck with deionized water and/or ethanol.

b. Check the “Clean deck and carriers” box.

5. Check condition of carriers and other devices.
a. Visually inspect the instrument for any obvious signs of damage.
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Forensic Biology

b. Clean the pedestals and racks with water and/or ethanol.
c. Check the “Check condition of carriers and other devices” box.

Empty and clean Tip Waste/Liquid Waste.

a. Remove the tip waste receptacle and empty tips into trash.
Replace plastic trash bag in tip waste receptacle if needed.
There is no liquid waste to empty.

Clean the tip eject plate with deionized water and/or ethanol.

Check the “Empty and clean Tip Waste/Liquid Waste” box.

o an o

Clean each channel: stop disk, o-ring, and tip eject sleeve.
a.  Wipe the pipettor channels with a kimwipe dampened with deionized watp=
b.  Check the “Clean each channel: stop disk, o-ring, and tip ejest'ecve” box.

Clean the side covers
a. Clean the Nimbus enclosure with deionized water and/or etha=<i.
b. Check the “Clean the side covers” box.

Select the “Check tightness of Pipette Channels” »c:;

a. Read the message that appears, remove the tip.eject plaie, close the door, and click “Continue”.

b. The system will automatically test the o-ring seals 6i"che channels.

Select the “Check cLLD” box.

a. Read the message that appears, engusa’thetip eject plate is still removed and the door is still closed, and
click “Continue”.

b.  The system will automatically “est 1iyuid level sensing.

Click “OK” to acknowledgc that the maintenance has completed successfully.

Replace the tip eje’t plate.

Click “Close”.

Exit the Maintenance software.

Semi-Annual Maintenance:

At least once a year a service engineer from Hamilton will perform maintenance and calibration of the Nimbus.

REFERENCES:

Microlab® Nimbus Independent Channel Operator’s Manual. Hamilton Robotics.

Microlab® Nimbus Enclosed Version Operator’s Manual. Hamilton Robotics.

Microlab® Nimbus Independent Channel Programmer’s Manual. Hamilton Robotics.
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6.7 7500 SDS CALIBRATION / VERIFICATION PROCEDURES

The information for the procedures detailed in this section was taken from the Applied Biosystems
7300/7500/7500 fast real-Time PCR System Installation and Maintenance Guide. When the yearly calibration
checks are performed, the analyst performing the calibration must check the lamp usage and status. Procedure
6.8.7.1 details checking the lamp usage and status. The halogen lamp located in the 7500 SDS Instrument has a
life span of approximately 1,000 hours. If the lamp has exceeded 1,000 hours, or if a message is displayed that
recommends changing the lamp, procedure 6.8.7.2 should be followed.

6.7.1 BLOCK CONTAMINATION CHECK

Purpose: A check for contamination allows a user to determine if there are iy ureus of possible contamination
in the wells of the plate holder that would artificially increase the fluoresgen e in fhose wells during a run,

thereby increasing the quantitation result.
Preparing the Check This check is performed without a plate being pesitioned in the plate holder; therefore, if
there is a plate in the holder, remove it, and then close the(carriage door over the sample block and lock it

down.

Note: This check is for information only and shbulataot be saved using the 7500 System software during or

after the check. See step 3 below for instrustionsion/documenting the contamination check.

Performing the Check

1. Turn on the instrument and <penthe SDS software. Click File>New. In the new document wizard click
Finish to accept the d¢rault parameters.

2. Using Filter A (tAMiilter position), open the ROI Inspector and take an image at 2048ms by selecting
Snapshot.

3. Observe the background fluorescence in the 96 wells. Note any wells that have significant fluorescence;
fluorescence indicates contamination. For documentation, perform a Screen Shot (Alt + PrintScrn) and
then paste it (Ctrl-V) into a Microsoft Word blank document.

4. To determine an acceptable background fluorescence level:

Push the instrument carriage and allow it to spring back to open it.

Put a new, clean, empty reaction plate without the cover into the sample block.
Push the carriage forward to close it.

a0 o

Take another image at 2048 ms. For documentation, perform a Screen Shot (Alt +PrintScrn) and
then paste it (Ctrl-V) into a Microsoft Word blank document.
e. Save as Calibration Contamination check (MM/DD/YY) in the appropriate instrument folder.
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5. If some of the wells still appear to have significant fluorescence, clean them per the instructions in
“Cleaning the Sample Wells”.

Recheck the wells after cleaning, following steps 1 through 3 above.
6.7.2 7500 REGIONS OF INTEREST CALIBRATION

MATERIALS REQUIRED:

1. Applied Biosystems Real-Time PCR System Spectral Calibration Kit
2. ROI Calibration Plate (Part No. 4349415)

3. Centrifuge and vortex

Purpose:
A Regions of Interest (ROI) calibration maps the positions of‘the “zells on the sample block so that the

software can associate increases in fluorescence during a surizvith4pecific wells of the plate. A calibration

image is needed for each well or filter to account for ainoi difierences in the optical path.

Preparing the Plate

Retrieve the ROI calibration plate from th¢ spictral calibration kit from the freezer in the amplified DNA
room freezer. Allow the plate to thaw. Leavi“ne optical film on the plate. (Do not discard the packaging as

the plate can be used up to three tinizs). “*hrtex and centrifuge the thawed plate to assure that the liquid is in

the bottom of the plate wells.

Creating a Plate Documen. for t'ie ROI Calibration

1. Start the instwmentand open the SDS software. Load the ROI calibration plate into the plate holder

position.

2. Click File > New

In the New Document wizard or dialog box click Finish to accept the default parameters. (The SDS

software automatically saves the ROI data to a set of calibration files on the computer hard drive). Click

OK if any ROI error is displayed.

3. In the SDS software, select Instrument > Calibrate

4. In the ROl inspector dialog box that appears, right-click the black area of the window, then select
Display Properties.

5. In the Image Viewer Control Properties dialog Box:
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a. Select Show Saturation
b. In the Sat Threshold field, enter 4000.
c. Click OK

6. In the ROI Inspector dialog box, set the lamp control:
a. Click Block up
b. Select Idle from the Lamp Control drop-down list

Performing the ROI Calibration
1. Inthe ROI Inspector dialog box:

a. In the Exposure Time field, enter 2048 for the 7500 and
b. Select Filter A.

2. Click Snapshot to generate an ROI image.

3. Determine if your ROI image is acceptable. An acceptabl¢im< eavill not have saturated red areas in any
wells. (A few red pixels in a well are acceptable).

If the ROI image appears over saturated, continucta reduce the number in the Exposure Time Field
(2048) by half until an acceptable image is okwained. Once the acceptable image is produced, print this
screen by pressing Alt + PrintScrn and thiun Cfrl V into a Microsoft Word blank document.

4. If your image is acceptable, Click Geieraie Calibration.
The software takes a snapshot, and tie: displays a message dialog box or an ROI image. A successful

calibration will have green cire.os around all wells.

If the calibration image i\ not siccessful, see pg 45 for of the 7500 Installation and Maintenance Guide for trouble

shooting.

5. Click Save Catibration to save the image for filter A. (An OK will appear in the dialog box for Filter
A). Remember to Save after every filter.

6. Repeats steps 1 through 6 for the remaining filters: Filters B, C, D and E. Reset the Exposure Time to
2048 before performing the calibration for each filter.

7. Click Done > File > Close and click NO to save the plate document.

Unloading the Plate

In the ROI Inspector dialog box, click Block Down and remove the plate. Return the plate to the packaging if

not performing background and optical calibration.

Implemented 05/7/2018 Issuing Authority: F. Healy, Quality Assurance Manager Page 54 of 70
k Printed documents are not controlled




o

Unit Policy Manual

Forensic Biology

6.7.3  Performing the Background Calibration on the 7500 SDS Instrument

MATERIALS REQUIRED:

1. Applied Biosystems Real-Time PCR System Spectral Calibration Kit
2. Background Plate (Part No. 4330124)
3. Centrifuge and vortex

Purpose A background calibration measures the level of background fluorescence in the instrument. The run
will perform continuous reads of a background plate containing PCR buffer for.1Gminutes at 60°C and
average the spectral results to a calibration file. The software can then use the file to remove the background

fluorescence from the run data.
Perform a background calibration after replacing the lamp or monthiy aepending on instrument usage.

Precautions Since the signal consists of fluorescence from seviralsources it is important to use gloves when

handling the plate, use a clean centrifuge and vortex, aid.dy not place the plates on the lab bench.

Preparing the Background Calibration Plate Retiieve the prepared background plate from the spectral

calibration kit from the freezer in the ampi:fiedd DNA room. Allow the plate to thaw (Do not discard the
packaging as the plate can be used up.to th:ee imes). Vortex and centrifuge the thawed plate to ensure that

the liquid is in the bottom of the plate, wells.

Creating a Plate Documen tor the Background Calibration

1. Place the preparced piaieinto the plate holder and close the tray/door. Start the instrument and open the
SDS softwarc. “Zlic.» File > New.

2. Configure the New Document Dialog box:
a. Select Assay >Background.
Select Container > 96-Well Clear.
Select Template > Blank Document
In the Operator field, enter a name.
In the plate Name field, enter : Background_<date MMDDYY> and click Finish.

o a0 o

3. In the SDS software select File > Save As. On 7500 #1, navigate to C:\SDS1.2\Documents and save.
On 7500 #2, navigate to D\: > SDS 1.2 >SDS Documents and save. Select Save as type > SDS
Documents (*.sds).
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Performing the Background Calibration In the SDS software: Select the Instrument tab and click Start. The
instrument begins the calibration run after the heated cover comes to temperature. After the run is complete,

click OK. The background run may take 10 minutes.

Analyzing the Background Calibration Data

Click the green arrow or select Analysis > Extract Background. The software extracts the
background signal then displays Background Extraction Complete. Click OK.

If the message indicates the image exposure is too low, see pg 56 of the 7500 Installation and Maintenance Guide for
trouble shooting.

In the plate document, select the Results tab, then Spectra tab. Print this yage for the Background
Calibration records and to show that the instrument is free of significari: contaminants.

Inspect the raw data for irregular spectral peaks that excees” the following fluorescent standard units

(FSU). All wells should be selected.

Filter L ESU

A,B,C,D >72,000
(7000/7550) |

E (7500) « + - >90,000

If the fluorescence exceeds the FSU ndivated, see pg 64 of the 7500 Installation and Maintenance Guide for trouble
shooting.

If a contaminant i obs'rved (high fluorescent data), see pg 108 of the 7500 Installation and Maintenance Guide for

c]eaning contcwinan.:

Inspect the background plate image for bright areas of fluorescence and perform a Screen Shot (Alt +
PrintScrn) and then paste it (Ctrl-V) into a Microsoft Word blank document for documentation.

Select File > Close
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6.7.4 PERFORMING THE OPTICAL CALIBRATION FOR THE 7500 SDS INSTRUMENT

MATERIALS REQUIRED:

1. Applied Biosystems Real-Time PCR System Spectral Calibration Kit
2. ROI Calibration Plate (Part No. 4349415)
3.  Centrifuge and vortex

Purpose: The optical calibration compensates for the physical effects of the additional filter present in the
7500 instrument and needs to be performed after every 7500 system backgrounad alibration.

Preparing the Optical Calibration Plate

Retrieve the prepared ROI plate from the spectral calibration kit frors<die reezer in the amplified DNA room.
Allow the plate to thaw (Do not discard the packaging as the pl<te ¢in be used up to three times). Vortex and
centrifuge the thawed plate to ensure that the liquid is in th«"bottom of the plate wells.

Creating a Plate Document for the Optical Calibration

1. Start the instrument and open the SDS seftviare.” Load the ROI calibration plate into the plate holder
position.

2. Click File>New.

3. Configure the New Dosemcat Dialog box:

a. Select Assay >Calibri tion.
Select Contzim »r -+56-Well Clear.
Select Temp'ate ~ Blank Document
In the Opersar field, enter a name.

o a0 o

In the plat: Name field, enter :
Calibration_<date MMDDYY> and click Finish.

4. In the SDS software select File > Save As. On 7500 #1, navigate to C:\SDS1.2\Documents and save.
On 7500 #2, navigate to D\: > SDS 1.2 >SDS Documents and save.

Performing the Optical Calibration
In the SDS software: Select the Instrument tab and click Start. The instrument begins the calibration

run (10 min.) after the heated cover comes to temperature. After the run is complete, click OK.

Analyzing the Optical Calibration Data

Click the green arrow or select Analysis > Extract. The software extracts the optical calibration then

displays a message indicating the extraction is complete. Click OK.
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Click on the Results and Spectral Tabs. Select all wells and print this screen. Inspect the raw background

data for any irregular spectral peaks.
For any error messages, see pg 64 of the 7500 Installation and Maintenance Guide for trouble shooting

Click File>Close.

6.7.5 PERFORMING THE PURE DYE CALIBRATION ON THE 7500 SDS INSTRUMENT

MATERIALS REQUIRED:

1. Applied Biosystems 7500 Real-Time PCR Systems Spectral Calibration Kit I
(PN 4349180 containing Pure Dye Plates FAM, JOE, NED, ROX, SYRR &rces; TAMRA, and VIC).

2. Centrifuge and vortex

Purpose During a pure dye calibration run, the system cclieals spectral data from a series of pure dye
standards and stores the spectral information for the pure Cye scandards in the pure spectra run file, a

calibration file in the SDS directory.

The software then uses the pure spectra da‘a driringsubsequent runs to characterize pure dyes and distinguish

the individual contribution of each dye in'+he woliective fluorescence collected by the instrument during a run.

Important! Before performing a »uircidye calibration, you must perform an ROI calibration, a background

calibration, and an optical ¢elibraion.

Preparing the Plate Z\etreve the pure dye plates from the spectral calibration kits from the freezer in the
amplified DNA rizam. Allow the plates to thaw (~5 minutes). NOTE: Do not remove a pure dye plate
from its packagiig until it is ready to be used. The fluorescent dye in the wells of each pure
dye plate is photosensitive. (Do not discard the packaging as the plates can be used multiple times).
Leave the optical film on the plates. Although multiple pure dye plates are in Spectral Calibration Kit I, only
the plates that are currently used for the quantitation chemistry being employed need to be run. For
Quantifiler and Quantifiler Duo, only FAM, VIC, ROX, and NED need to be run.

Creating a Plate Document for the Pure Dye Calibration

1. Start the instrument and open the SDS software. Click File > New.

2. In the New Document Wizard dialog box:
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Select Assay > Pure Spectra.

Select Container > 96-Well Clear.

Select Template > Blank Document.

In the Operator field, enter your initials.

In the Comments field, enter the plate bar code number.

moe 0 o

Click Finish. Note: It is not necessary to name or save the pure dye plate document. The SDS
software automatically saves the pure dye data to a calibration file on the computer hard drive.

Selecting the Dve
In the Pure Spectra Calibration Manager dialog box:

In the Dye List field, select a pure dye to calibrate.
Click Calibrate.
If you are prompted to disconnect the plate document, click’r es.

oo o

A message prompts you to load the plate. Do not click Yas or N¢ at this point.

Preparing and Loading a Pure Dve Plate

1. Remove the appropriate Pure Dye plate from its pactaring. Do not discard the packaging as the plate can

be used multiple times. Leave the optical filiivan the plate.

2. Vortex and centrifuge the thawed plate to assure that the liquid is in the bottom of the plate wells.

3. Verify that the pure dye plate that yoware/aboui to load matches the dye selected in the Pure Spectra
Calibration Manager.

4. Load the plate in the instrument with the notch in the upper right corner.

Performing the Pure Dye Calibie%ion

1. In the dialog box<na  presipts you to load the plate click Yes. The run takes ~5 minutes to complete.
2. When the SDS s¢#ware completes the run, remove the pure dye plate from the SDS Instrument, place it
back into its pacinonig, and place it back into its respective spectral calibration kit in the freezer.

Calibrating remaining dyes:

Click Next Dye >.
2. Repeat the procedures in Preparing and Loading a Pure Dye Plate and Performing the Pure Dye
Calibration to run the remaining pure dye plates.

3. After you calibrate the instrument with all pure dyes provided in the spectral calibration kits, click
Finish.

Analyzing the Pure Dye Calibration Data
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When each pure dye plate is run, the SDS Software automatically creates and saves a plate document for each

dye. After you calibrate all of the pure dye plates, the plate documents remain open behind the plate

document displayed by the software. To complete the calibration, analyze all open pure dye documents:

Aow N =

extraction, then displays a message:

From the Windows menu, select the plate document to analyze.

Select the Results tab, then select the Spectra tab.

Select all wells of the plate document by clicking the upper-left corner of the plate grid.
Click the green arrow (or select Analysis > Extract Pure Spectra). The SDS Software completes the

If the software displays:

Do this:

Pure Spectra Extraction Complete — The analysis

is successful.

Click OK, then go to ste. 5.

Important! The bure dye
calibration is nut vezaplete at this
point. Befcre<icsing the plate document
you must ir spécd the Spectra plot as

explainec in steps 5 through 8 below.

Repair Message—“The following wells require

. »
repalr e

('lig‘—O?then go to step 5.

(For information on how the software
auto-repairs calibration spectra, see
“About Pure Dye Spectra” on pg 79 of the
Applied Biosystems 7300/7500/7500 Fast
Real-Time PCR System Installation and

Maintenance Guide.

«

Error Message— ‘Pure Swoctre Extraction

1
Detected an Unknown .‘rror. . .”

Click OK, load the plate, then run the
pure dye plate again.
If the calibration continues to fail, perform

the calibration with a new pure dye plate.

5. In the pure dye plate document:

a. Select the Results tab.
b.  Select the Spectra tab.

6. Select all wells of the plate document by clicking the upper-left corner of the plate grid.

7. Using the tables below as a reference, verify that the peak for the spectrum of the pure dye occurs at the
correct filter. For documentation, Print the spectra for each dye (Alt + Print Scrn; then open a new
blank Microsoft Word document and Ctrl V to paste the spectra). If the peak for the spectra of a dye
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occurs in the wrong filter, you may have run the wrong dye plate during the calibration. Repeat the

procedure using the correct dye.

Instrument Pure Dye Filter Peak (nm)
7500 System FAM | & | smanwm | @
| vic B ~550 nm :
NED c -580 nm ‘ _
!
ROX ‘ oy | -sl0nm | . :' - :
;
|
q ——

8. Select File > Close. Important! Do not close a plate document until you have extracted it. During
the calibration, the software creates plate documents for each pure dye plate as it was run. You must

extract each one individually before closing it.

9. Repeat steps 1 through 8 to extract the calibration data for the remaining pure dyes.

6.7.6  Running the TagMan RNase P Plate Data on the ABI 7500 SDS

MATERIALS REQUIRED:

1. Applied Biosystems Real-Time PCR System Spectral Calibration Kit
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2. TagMan RNase P Instrument Verification Plate (Part No. 4350584)
3. Centrifuge and vortex

Purpose The TagMan RNase P Instrument Verification Plate run verifies the performance of an Applied
Biosystems 7500 SDS instrument. The RNase P plate is pre-loaded with the reagents necessary for the

detection and quantification of genomic copies of the human RNase P gene.

The RNase P plate contains five replicate groups of standards, two unknown populations and four no template

control wells. After the run, the SDS software will assess the instrument performance.

Preparing the TagMan RNase P Plate Retrieve a prepared TagMan RNase P-vciification Plate kit from the

freezer in the amplified DNA room and allow the plate to thaw (approximatzly 5 ‘ninutes). Vortex and
centrifuge the thawed plate to ensure that the liquid is in the bottom #i the late wells. If the RNase P plate

has a compression pad on it, remove it from the plate.

Creating a Plate Document for the RNase P Verification Ri‘n

1. Start the instrument and put the RNase P plate in th¢vr strument.
2. Open the SDS software and click File >'Ne'v.

3. In the New Document Dialog bex:
a. Sclect Assay >Absolute Quant fication (standard curve).
Select Container > 96-V. eli'Clear.
Select Template >+Aty_ RNase P Install
In the Operator f eld, ¢ater a name for the RNase P plate (i.e. RNase P MMDDYY) click Finish
In the SDS s#ity arcyuclect File> Save As. (Navigate to D\:>AppliedBiosystems>SDS Documents

o o

and Save)

Performing the Ver fication Run In the SDS software: Select the Instrument tab and click Start. (The

instrument default parameters should be correct. The RNase P plate volume is 50ul). The instrument begins

the run which lasts approximately 1.5 hours. After the run is complete, click OK.

Analyzing the TagMan RNase P Plate Data

1. Select Analysis > Analysis Settings. Select Auto C, >Click OK. Click the green arrow or select
Analyze.

2. Assess the results. In the plate document: Select the Results tab then select the Amplification Plot
tab.
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4. Display the data: from the Amplification Plot tab:
a. Click the upper-left corner of the plate grid to select all wells.
b. Select Data > C, vs. Well Position to display the plots. Save this data.
5. Verify the uniformity of each replicate population by comparing the groupings of C, values.

If outliers are present, omit and reanalyze (see page 93 of the 7500 Installation and Maintenance Guide for
trouble shooting, this will apply to the 7000, as well).

6. In the results tab, select the Standard Curve tab and verify that the R® valu¢ is > 0.990. Save and print
this data.

7. In the Report tab, calculate the verification value of the 5.500: cops;7and 10,000-copy populations:

a. For the 5,000-copy populations, in the Report tabjsiroll.to a sample in the 5K population. Apply the
value in the Mean Qty and StdDev Qty columns 1o th following equation:

5K value -~ Mcn Qty + 3(StdDev Qty)

b.  For the 10,000-copy population;, i the'Report tab, scroll to a sample in the 10K population. Apply
the value in the Mean Qty aiid.Stc Dev Qty columns to the following equation:

10: value = Mean Qty — 3(StdDev Qty)

8. Compare the vaitues ofdie 10K and 5K-copy populations. If the 10K value is greater than the 5K value
the 7500 has parsed.

9. With all wel's chosen, print the Report. Save the Tabular Report Data and the Standard. You may
discard the Raw Data and the Delta Rn vs Cycle Data pages. It is recommended that the calculations
performed above be written on one of the Tabular Report Data pages.

10. Close Program. If asked to Save, click “yes”.

Remove the plate and discard. (note: the plate cannot be re-used)

6.7.7 Monitoring and Replacing the Lamp on the 7500 SDS Instrument

6.7.7.1 Monitoring the Lamp Status
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The halogen lamp located in the 7500 SDS Instrument has a life span of approximately 1,000 hours. If the
lamp has exceeded 1,000 hours, or if a message is displayed that recommends changing the lamp,
procedure 6.8.7.2 should be followed.

1. Select File > New.
2. In the New Document Wizard, click Finish.

In the SDS Software, select Instrument>Lamp Status/Replacement. In the Lamp
Status/Replacement dialog box, the usage hours and lamp current are displayed. The Condition field
will indicate one of the following:

Good—the lamp is functioning well. There is no need to replace ti e lamp bulb at this time. Click
Close.

Failed—The lamp bulb must be replaced. Click Close, theirieplice the lamp.

Change Soon—the lamp bulb usage is above 2000 hou’ss. ¥ie. recommended to replace the lamp
soon. Click Close, then replace the lamp.

Warning messages may be displayed before or during w.run that indicate low lamp current. See page 121 of the

Installation and Maintenance Guide for the/¢ messages, what they are describing, and how to proceed.

6.7.7.2  Replacing the Halogen "<my on the 7500 SDS Instrument

The halogen lamp located in the 7500 5DS Instrument has a life span of approximately 1,000 hours. If the
lamp has exceeded 1,000 houss, ar 1f a message is displayed that recommends changing the lamp, this

procedure should be fillowed

MATERIALS REODZunTD:

1. Halogen bulb (12V, 75W)
2. Small pointed object, for example a screwdriver.
Important: Wear powder-free gloves when you handle the lamp.

1. Power off, then unplug the 7500 SDS Instrument. Allow the instrument to cool for 15 minutes.

2. Open the access door to the Instrument:
Insert a thin screwdriver or other object into the keyhole on the edge of the front access door, then push

to unlatch the door. Open the door.
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3. Remove the lamp from the instrument:
Slide the lamp release lever downward. Firmly grasp the lamp and lift it up and out of the slotted mount.

4. Inspect the lamp for signs of failure (see the Installation and Maintenance Guide page 124 for
indications of lamp failure).

5. Place the new lamp into the instrument
Slide the lamp release lever upward. Firmly grasp the lamp, place it into the slotted mount, then carefully

slide the lamp downward into place.

6. Close the access door.
7. Plug in and power on the 7500 SDS Instrument.

8. Open the 7500 System software program.
If the Quick Startup document dialog box is not open, selcct Fi¥& > New. In the New Document

wizard, click Finish. In the SDS software, select Iristr_ment > Lamp Status/Replacement and

click on Reset lamp timer then close.

9. In the ROI Inspector dialog box, select Lamp Coutrol > Idle.

10. While the instrument is running, Yok, thiodigh the grating of the access door and verify that the lamp
is illuminated, then click Done!

Important! After replacing'the’amp, the following calibrations must be performed: ROI Calibration,
Background and Optical<Calibrations, Pure Dye Calibration, Instrument Performance Verification

(RNase P Plate).
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6.7.8 PROCEDURE FOR THE CALIBRATION CHECKS OF THE THERMOCYCLERS

The thermocyclers used for the polymerase chain reaction amplification of DNA are located in the
Amplification Room of the Forensic Biology Unit. A calibration verification test and temperature non-
uniformity test are conducted on each thermocycler approximately every six months. The verifications are

conducted by an outside vendor.

7.0 COLLECTION KITS AND SUPPLY ORDERING

7.1 PREPARATION OF EVIDENCE COLLECTION KITS

The Forensic Biology Unit provides officers, investigators, and sexual assauit nurses/with six types of kits used in

the collection of biological evidence.

In general, the Laboratory Technician is responsible for preparjng <74 disseminating the kits, however, the unit
as a whole is responsible for these kits. A point person may, L 24signed the responsibility of these kits. A
minimum stock should be kept on hand at all times in order (o f.¥requests promptly. Kit components should
also be prepared and kept on hand. Kits and kit components saould be made on a sterile surface. Use protective

gloves and a laboratory coat when preparing and ‘andli g kits and kit components.

7.1.1 REFERENCE MOUTH SWAL' C )YLZECTION KITS

Keep 60-100 kits on hand at all tin:es.

Place the following items i1 a R¢ference Mouth Swab Collection Kit envelope (a manila envelope with ‘SDPD
REFERENCE MOUTH s WAL COLLECTION KIT’ printed on the front):

= 2 sterile, papcr/wrapped swabs

® 1 small “SDPD Reference Mouth Swabs” envelope

® 1 smaller manila envelope

® 1 evidence seal

® 1 pair of large latex gloves

® 1 copy of ‘Instructions for the Collection of Reference Mouth Swabs’

® 1 copy of the SDPD consent form
Individual kits can be packaged together in large paper bags containing 20 kits.
7.1.2 BIOLOGICAL STAIN COLLECTION KIT

Keep 60-100 kits on hand at all times.
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Place the following items in a Biological Stain Collection Kit envelope (a manila envelope with ‘BIOLOGICAL
STAIN EVIDENCE COLLECTION KIT’ printed on the front):

= 2 sterile, paper-wrapped swabs

" 1 tube containing sterile water

= 1 small ‘SDPD BIOLOGICAL EVIDENCE SAMPLE’ envelope
® 1 smaller manila envelope

= 1 evidence seal

® 1 pair of large latex gloves

® 1 copy of ‘Instructions for the Collection of a Biological Stain’
7.1.3  VICTIM SEXUAL ASSAULT EXAMINATION KIT

Keep 60-80 kits on hand at all times.
Place the following items in a Victim San Diego Regional Sextual Assault Evidence Collection Kit envelope:

= 5 swube tubes

" 1 Pubic Hair Combings envelope with comb

® 1 Head Hair envelope with bindle

" 1 Left Fingernail Scrapings envelope vith.Z fingernail swabs in a bindle

" 1 Right Fingernail Scrapings envelopc withZ fingernail swabs in a bindle

® 1 piece of tissue paper

® 1 evidence seal

" 1 victim label sheet (1 Carvial Swabs, 1 Vaginal Swabs, 1 External Genital Swabs, 1 Oral swabs, 1 Rectal
Swabs sticker, 1 Left sreast:Swabs, and 1 Right Breast Swabs sticker)

7.1.4  SUSPECT SI"aUAL ASSAULT EXAMINATION KIT

Keep 40-60 kits on hand at all times.
Place the following items in a Suspect San Diego Regional Sexual Assault Evidence Collection kit envelope:

® 5 swube tubes

® 1 Pubic Hair Combings envelope with comb

® 1 Head Hair envelope with bindle

® 1 Pubic Hair envelope with bindle

® 1 Left Finger scrapings envelope with 2 fingernail swabs in a bindle
® 1 Right Finger scrapings envelope with 2 fingernail swabs in a bindle
® 1 piece of tissue paper

= 1 evidence seal
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® 1 suspect label sheet (1 Penile Swabs, 1 Scrotal Swabs, 1 Oral swabs, 1 Left hand fingers swab, and 1 right
hand fingers swab stickers)

7.1.5 PHYSIOLOGICAL SAMPLES KIT

Keep 60-80 kits on hand at all times.

Place the following items in a Physiological Samples San Diego Regional Sexual Assault Evidence Collection

Kit envelope:

® 2 grey-capped blood vials (Vacutainer®) each in a cigar tube
® 1 urine bottle with sodium fluoride
® 1 custody seal

" 1 evidence seal

Blood vials and cigar tubes are provided by the Narcotics Unit.

7.1.6  FETAL TISSUE COLLECTION KIT

Prepared as needed.
Place the following items in a manila envelHpes

® 2 blue-capped 50mL conical vial: (1 154 spare)
®  Evidence seals

"  Procedure for collectingubc ted tetal material

A cooler and ice pacl‘wil. be provided to any investigators for transporting the fetal material to the Property
Room. Referenga.motth swab collection kits should also be provided to investigators for the purpose of

collecting samples ’om the mother and alleged father.
7.2 ORDERING AND RECEIVING COMMERCIAL KITS

7.2.1 Ordering procedure

Requests for supplies, reagents, and DNA typing kits will be placed in the Supply Order Log (electronic file)
located on the department network (G:\Laboratory\Tony\Ordering Log).

When orders are placed, the date ordered and the order confirmation number will be logged into the Supply
Order Log.

7.2.2  Receiving supplies
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The receipt of the supplies will be logged into the Supply Order Log. The packing slip received with the
supplies is initialed and dated then submitted to the Administrative Aide in charge of purchasing for the

laboratory.

7.2.3  Receiving chemicals

The receipt of the chemicals will be logged into the Supply Order Log. The packing slip received with the
chemicals is initialed and dated then submitted to the Administrative Aide in charge of purchasing for the
laboratory.

A record of the chemicals on hand in the Forensic Biology Unit will be maintamcd. “Any new chemicals (i.e.

not previously ordered/received) will require an MSDS to be on file in the (Tnit.
Chemicals need to have the date and the initials of the receiver or<the contiiner.

7.2.4 Receiving DNA kits

The kits used for DNA extraction, quantification, and typin ; must all be recorded in the Kit Receipt Log upon
receipt. In general, the lot numbers of every cainponent of the kit are recorded as well as the lot number of
the kit. Kit components may be stored in direrest l#cations and, thus, all kits components must be labeled

with the lot number of the whole kit, or tltenatively with an abbreviated kit ID # (e.g. IDP#-YY).

7.2.4.1  QUANTIFILER KiT$
Record lot numbers of the FCR/reastion mix, DNA standard, primer, and whole kit in the Kit Receipt Log.

The PCR reaction mix s'iould bolabeled with the whole kit lot number and stored in the reagent
refrigerator. The reduinder.4f the kit (in the original box) will be stored in the reagent freezer. Place ‘Not
QC’d, Do Not Use' #ackers on all kit components. Replace with “QC OK?” stickers once the quality control

tests have been -oiipleted and reviewed.

7.2.4.2 STR TYPING KITS
Record lot numbers of all components of the kit and the whole kit lot number in the Kit Receipt Log. The

PCR reagents box should be labeled with the whole kit lot number and stored in the reagent refrigerator. If
AmpliTaq is part of the kit, it must be placed in a freezer holder with tube numbered (1 thru X), labeled
with the whole kit lot number and stored in the reagent freezer. The ladder will be labeled with the whole
kit lot number and stored in the reagent refrigerator in the Amplification Room. Place ‘Not QC’d, Do Not
Use’ stickers on all kit components. Replace with “QC OK?” stickers once the quality control tests have been

completed and reviewed.

7.2.43  QIAGEN DNA INVESTIGATOR KITS (EZ1 or QiaSymphony)
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Record lot numbers of all kit components, except the buffers and proteinase K, and the whole kit in the Kit
Receipt Log. Discard the proteinase K and buffers. Place ‘Not QC’d, Do Not Use’ stickers on all kits until
quality control testing has been completed. Replace with “QC OK? stickers once the quality control tests

have been completed and reviewed.
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